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HA on Cisco ACI using FGCP over FGSP

In Cisco ACI, you can deploy the FortiGate Clustering Protocol (FGCP) over the FortiGate Session Life Support Protocol
(FGSP) to achieve high availability (HA). This deployment uses the following Cisco ACI components:

Component Description

Endpoint group (EPG) Container for collections of applications that is independent of addressing, VLAN,
and other network components.

Contract Defines communication between EPGs.

Service graph Provides the capability to insert L4-L7 devices (in this case, the FortiGate) into
Cisco ACI. Includes the policy-based redirect (PBR) feature, where the Cisco ACI
fabric redirects traffic between security zones to the firewall (the FortiGate in this
case) for inspection without requiring the firewall to be configured as the servers'
default gateways. This provides increased stability by minimizing network
changes.

Leaf and spine switches Switches in Cisco ACI spine and leaf architecture, where there are two layers of
switches: spine and leaf. The spine layer is the backbone of the network and
interconnects all leaf switches. Leaf switches are access switches that connect to
devices such as servers. See Cisco Data Center Spine-and-Leaf Architecture:
Design Overview White Paper.

Pod Set of interconnected Cisco ACI leaf and spine switches that a specific Cisco
Application Policy Infrastructure Controller (APIC) cluster is managing. Pods that
the same APIC cluster is managing are considered part of the same Cisco ACI

Fabric.

Inter-pod network (IPN) Connects pods to allow for establishment of pod-to-pod communication (east-
west traffic).

Tenant Highest-level object in the ACI Fabric that contains EPGs and bridge domains
(BDs).

Bridge domain Domain that carries out forwarding and bridging processes.

In this deployment, traffic is redirected to the FortiGate for inspection. After inspection, FortiGate forwards the traffic to
the Cisco ACI. The FortiGate is in one-arm mode in this scenario. This configuration supports asymmetric traffic flow,
where the original and return traffic are inspected by different FortiGates.
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HA on Cisco ACl using FGCP over FGSP

EPG —— AClFabric — EPG

This solution uses Cisco ACI service chaining with PBR and the Anycast feature. The topology for this deployment is as

follows:

o Two FGCP clusters:

« Each cluster in a different pod

« Each cluster has two FortiGates
o FGSP across all pods

This deployment requires the following configurations:

o Due to the Cisco ACI requirement to have an Anycast IP address and a MAC address, you must configure both

FGCP clusters with the same HA group ID.
« PBR data interface must use the same ports on both clusters.

« One VLAN is created for traffic processing. It has the same IP and MAC addresses on both clusters.

e peer-ipand session-sync-device use different ports with different MAC addresses.

Same HA group-ID

Different HA password

Different peer-IP and session-sync interfaces
Same data interface

HA1 :

HAZ ]
23 24 31 23 1T
o 75799;54; ”””””””” PBR data

a Ses-syn-
dev2 devi Peer IP 2255““
ACI Fabric
‘ Ses-syn-
Ses-syn-  Peer IP Ses-syn- 355;!‘”’ Peer IP davi

FER data dev2 devi dev: PBR data
2 =Hl

1 2
HA1 25
HAZ

FGCRaluster2

Same HA group-ID

Different HA password

Different peer-IP and session-sync interfaces
Same data interface
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HA on Cisco ACl using FGCP over FGSP 6

As no provisioning configuration is pushed from the APIC to the FortiGate, importing a device package to APIC is not
required.

FGCP over FGSP with ACI integration with example

In this example, the configuration is achieved using FortiGate 1101E running FortiOS 6.4.2 and Cisco ACI 5.2.

The following diagram shows the topology for this example configuration, which consists of two pods.

Pod1 Pod2

Cluster1

HA Group ID: 112
Diff ha password
Peer ip interface (under P2)
Vian801: 172.16.88.1/24

Cluster2
HA Group ID: 112
Diff ha password
Peer ip interface (under P5)
Vian801: 172.16.88.2/24 Ve ST 22

Node ID: 221

Name: Spine_211
Node ID: 211

1 14 1 14

172.16.1.254 172.16.1.254
; PBR e ] . PBR d
III . PeerlP ||| III . PeelP . o s |||
. . 20
3 SessionSync114 RLANN 5 SessionS: 12 5
HA G - HA
FG1101E-2 FG1101E-3
FG1101E1 FG1101E-4
R T 192.168.139.18 192.168.139.19 192.163.139.20

two FGCP Clusters

The configuration has the following settings:

« Each pod contains a FGCP cluster with two FortiGate 110Es.

e The pods communicate via their IPNs.

o The clusters share the same HA group ID, 112.

¢ The clusters share the same VLAN, VLAN801, with IP address 172.16.88.1/24.
« The clusters have different HA passwords.

« Peer IP interfaces are configured as follows. If you do not disable the port that the other cluster is using for its peer
IP interface, the peer IP interface connected to the switch will detect the same VMAC over multiple interfaces, due
to having the same HA group ID with the same VMAC with interfaces enabled:

« For cluster1, the peer IP interface is under port2. Port5 is disabled on cluster1 FortiGates.
o For cluster2, the peer IP interface is under port5. Port2 is disabled on cluster2 FortiGates.

« There is session synchronization between the two clusters. Session synchronization is configured as follows. If you
do not disable the port that the other cluster is using for session synchronization, session synchronization does not
work as it is unable to learn the peer FGCP VMAC, due to having the same HA group ID with the same VMAC with
interfaces enabled.

« Cluster1 uses port3 for session synchronization. Port6 is disabled on cluster1 FortiGates.
» Cluster2 uses port6 for session synchronization. Port3 is disabled on cluster2 FortiGates.
« Both clusters have the state of the session and the session will not be dropped.

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.



HA on Cisco ACl using FGCP over FGSP 7

In a production environment, configuring multiple session-sync-dev interfaces for load balancing session sync
packets is recommended.

The following diagram provides a more detailed view of what occurs at the leaf level. Each pod contains a Tenant (here
named "Unmanage"), which contains three BDs: Web, App, and FwSvc_OneArm-BD. The Web and App BDs each

contain an EPG with a virtual machine. A contract defines communication between the Web and App EPGs. Traffic flow
between the Web and APP EPGs uses the PBR policy to flow to the FortiGate for inspection, and to its destination after

inspection.
_ Pod1 _ ) Pod?2 .
e a
/ Tenant Unmanage (Unmanage VRF) \ / Tenant Unmanage (Unmanage VRF) \
P
4 Web-BD h | Web-BD

Unmanage-
App EPG

Unmanage- Unmanage-

Web EPG

A

FwSvc OneArm-BD
Gw: 172.16.1.1/24

FwSvc_OneArm-BD
Gw: 172.16.1.1/24

FGT-OneArm-PBR policy
172.16.1.254
Mac: 00:09:0F:09:70:02

FGT-OneArm-PBR policy
172.16.1.254
Mac: 00:09:0F:09:70:02

The following steps assume that a tenant is already created.

You must configure the deployment on the Cisco APIC management console, then configure the necessary options in
FortiOS.

Configuring the Cisco APIC management console

To configure the deployment on the Cisco APIC management console:

1. Log in to the Cisco APIC management console.
2. Configure the BDs:
a. Onthe Tenants tab, go to Unmanage > Networking > Bridge Domains.
b. Configure the App BD:
i. Click Add Tenant.
ii. Inthe Name field, enter App.

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.



HA on Cisco ACl using FGCP over FGSP 8

iii. For IP Data-plane Learning, select yes.

el APIC

cisco

Tenants Fabric Virtual Networking La- S Admin Opt

Apps Integrations

on | Unmanage | Custl | SCB1 | Hybrd

v Bridge Domain - App

Name: App
Alias:

Description:

Global Alias

Tags

Advertise Host Routes: [
Enable Scaled L2 Only (Legacy) Mode: [

Scaled L2 Only (Legacy) Mode: No

VRF: [Unmanage i
Resolved VRF: Unmanage/Unmanage

L2 Unknown Unicast

IPV6 L3 Unknown Multicast

Multi Destination Flooding

PIM: []
PiMve: [
IGMP Policy

ARP Flooding: ]

# bats-piane Leaming: (0 [ R

c. Configure the Web BD:
i. Click Add Tenant.
ii. Inthe Name field, enter Web.
iii. For IP Data-plane Learning, select yes.
d. Configure the Fw-Svc-OneArm BD:
i. Click Add Tenant.
ii. Inthe Name field, enter Fw-Svc-OneArm BD.
iii. For IP Data-plane Learning, select no.
3. Goto Policies. Configure a PBR policy:
a. Enable Anycast Endpoint. This is required to allow the traffic to flow through either cluster.
b. Under L3 Destinations, add the PBR IP and MAC addresses. In this case, the addresses are 172.16.1.254 and

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.



HA on Cisco ACl using FGCP over FGSP

00:09:0F:09:70:02, respectively.

i)

cisco AP‘C

system [RCELH fabric  Virtual Networking  L4-L7 Services ~ Admin  Operations  Apps Integrations
ALLTENANTS | AddTenant | Tenant Search: [EEIRORGGSSEMMMMN | commen | Unmanage | Custl | SCBI | Hybrid
Unmanage )

© L4-L7 Policy-Based Redirect

~ Name Description Hashing Threshold ~ Resilient ~ Min Max Threshold Down
Algorithm Enable Hashing Threshoid  Threshold  Action
DR L4-L7 Policy-Based Redirect - FGT-OneArm-PBR [RY~ Ix]
B Contracts
Policy Faults History
o & %
Properties

( ~
Destination Type: ( L1 B

1P SLA Monitoring Policy:
Oper Status: Enabled
Enable Pod ID Aware Redirection: []

Hashing igorithm: dip E——

Anycast Endpoint: [
Resilient Hashing Enabled: []

L3 Destinations:

+
alP Destination MAC Redirect  Additional Description Oper
Name Health  IPva/IPv6 Status
= Group
IPSLA
172.16.1.254 00:09:0F:09:70:02 0000 Enabled

[ L4-L7 Redirect Health ¢
L4

o

& Match Rules

4. Configure an L4-L7 device:
a. Goto Services > L4-L7 > Devices.
Create a new device.
Ensure that Managed is unselected.
From the Physical Domain dropdown list, select FWDomain_Unmanage.
Under Devices, add the FortiGate. In this example, the device name is FG1101E-1, and the interface is Port1.

Under Cluster Interfaces, add the FGT1101E-1 port1 as a concrete interface and vlan-400 as the
encapsulation.

e APIC e ~ 0000

System  [MCUENIEE  Fabric Virtual Networking ~ L4-L7 Services ~ Admin  Operations Apps Integrations

ALLTENANTS | Add Tenant | Tenant Search: [ HGRRGRGENN | common | Unmanage | Custl | SCB1 | Hybrid

- ® 2 0 T

Unmanage L4-L7 Devices - FG1101E_Unmanage

00
(O Quick Start

Policy  Fadts  History

Managed 0

Name: FG1101E_Unmanage + Name Interfaces
Alias:
FG1101E-1 Port1 (Pod-1/Node- 112/eth1/11)
Seniice Type: Fiewal
Device Type: PHYSICAL
Prysica Domain: 3 NFATMATAEIERE

Promiscuous Mode: []

N
4 N N FG1101E-1/[Port1] a0
Functon Type: ( GoThough  [EKCOCNN L1 | L2 int vian-400

Cluster Interfaces:

5. Configure the service graph template:
a. Goto Services > L4-L7> Service Graph Templates.

b. Create a new service graph template that goes from the consumer (Web EPG) to the L4-L7 device that you
create to the provider (App EPG).

c. For Firewall, select Routed.

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.



HA on Cisco ACl using FGCP over FGSP

d. For Route Redirect, select true.
System [MCUCHWCM Fabric  Vitual Networking  L4-L7 Services  Admin  Operations  Apps Integrations

ALLTENANTS | AddTenant | Tenant Search: [ ENSORGSSHMMMMN | common | Unmanage | Custl | SCBI | Hybrid

Unmanage L4-L7 Service Graph Template - FG1101E-OneArm_Unmanage

O Quick Start
[ unmanage
[ Application Profiles
[ Networking
= Contracts consumer

& Policies

Topology

B Senvices
L
B Service Parameters
[ Service Graph Templates
(® FG1101E-OneAm_Unmanage FG1101E_Unmanage Information
[ Function Node - N1 Firewall: Roued
B Router configurations
B Function Profies
[ Devices
Bl F61101E_Unmanage

B Imported Devices

6. Create afilter:
a. Goto Contracts > Filters.
b. Create a new contract.
c. Inthe Name field, enter Allow_Any.
d. Under Entries, configure one entry that allows all traffic.

System [MENEWEE  Fabric Virtual Networking ~ L4-L7 Services ~ Admin  Operations Apps Integrations
ALLTENANTS | AddTenant | Tenant Search: [ ISRIRRRGENN | common | Unmanage | Cust! | SCB1 | Hybid

Unmanage Filter - Allow_Any

(> Quick Start

B8 Unmanage
B Application Profiles
[ Newworking -
B Contracts Name: Allow_Any

[ Standard Alis;

B Ay Description:

B Teboos

i Imported Tags

[ Filters ikt T Scqeaabin by coun
Y Global Alias

Entries
B Poicies
B Senvices Neme Als EherType  ARP Fiag

| —=YEN}
[ Service Parameters any P
7. Configure the contract:
a. Goto Contracts > Standard.
b. Create a new contract.

Provider
. E O,
FG1101E_U...
N1
Route Redirect: true
1P Protocol Match Stateful  Source Port/ Range Destination Port  Range
only
Fragme From To From To
unspecified Fase  False

c. Under Subjects, configure the Allow_Any filter. This contract is now applied between the Web and App EPGs.
At this point, when the firewall integration is not configured, the Web and App EPGs can communicate freely

without any inspection.
8. Apply the service graph template:

a. Under Services > L4-L7 > Service Graph Templates, right-click the service graph template that you created,

and select Apply L4-L7 Service Graph Template.

For Contract Type, select Select Existing Contract Subject.

- ® 2 0 T

FortiOS Cisco ACI Administration Guide

From the Consumer EPG / External Network dropdown list, select the Web EPG.
From the Provider EPG / Internal Network dropdown list, select the App EPG.

From the Existing Contracts with Subjects dropdown list, select Allow_Any.
From the Service Graph Template dropdown list, select FG1101E-OneArm_Unmanage.
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HA on Cisco ACl using FGCP over FGSP

g. Under Consumer Connector, configure the following:
i. From the BD dropdown list, select Fw-Svc-OneArm.

ii. From the Redirect Policy dropdown list, select FGT-One-Arm-PBR.

iii. Leave the Service EPG Policy field empty.
iv. From the Cluster Interface dropdown list, select int.

h.

Apply L4-L7 Service Graph Template to EPG(s)
STEP 2 > Graph

Service Graph Template: Unmanage/FG1101E-OneArm_Unmanage 2

Consumer

c = -
FG1101E_U...

Unmanage-...

N1

Policy-Based Redirect: true
Consumer Connector

™\
Type Gﬁl Route Peering )
/

BD: Unmanage/Fw-Svc-OneArm iz

BD that connects the two devices
L3 Destination (VIP): []
Redirect Policy: | Unmanage/FGT-OneArm-PBR =

Service EPG Policy:

Cluster Interface: | int 2

Under Provider Connector, configure the following:
i. For Type, select General.

ii. Configure other fields with the same values as for the consumer connector.

9. Configure a device selection policy:

a. Goto Services > L4-L7 > Devices Selection Policies.

b. Create a new policy.

c. Forthe contract, select Any.

d. Forthe graph, select FG1101-OneArm_Unmanage.

e. From the Devices dropdown list, select FG1101E_Unmanage.

11

Provider

Unmanage-...

10. Goto Services > L4-L7 > Deployed Graph Instances. Confirm that you can see that the configured service graph
has been deployed as configured.

FortiOS Cisco ACI Administration Guide
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HA on Cisco ACl using FGCP over FGSP

system [RCUCWCE  Fabric Virtual Networking ~ L4-L7 Services ~ Admin  Operations
ALLTENANTS | AddTenant | Tenant Search: (USROS | common | Unmanage | Custl | SCBI | Hybrid

Unmanage

[ it blaragement Configursion for LA-L devices

Configuring FortiOS

To configure the deployment in FortiOS:

1. Create a PBR virtual domain (VDOM). You must make all following configurations in the PBR VDOM.
2. Configure a VLAN interface under port 1 with VLAN ID 400:
a.

5Q 0 20T

Go to Network > Interfaces.
Click Create New.

In the Name field, enter vlan400.
For Type, select VLAN.

For Interface, select port1.

In the VLAN ID field, enter 400.
In the VRF ID field, enter 0.

From the Role dropdown list, select LAN.

FortiOS Cisco ACI Administration Guide

L4-L7 Service Graph Instance - Any-FG1101E-OneArm_Unmanage-Unmanage

Topology

Provider

Device Cluster: FG1101E_Unmanage

Polic

12
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HA on Cisco ACl using FGCP over FGSP 13

i. Inthe IP/Netmask field, enter 172.16.254/255.255.255.0. Save the interface.

Edit Interface

Name @ vlan400
Alias

Type & VAN
Interface M portl
VLANID 400

VRFID €@ 0
Virtual domain € PBR

Role €@ LAN -

Address

Addressing mode m DHCP | Auto-managed by FortilPAM
IP/Netmask 172.16.1.254/255.255.255.0

Create address object matching subnet (B
Secondary IP address @ ]

3. Goto Policy & Objects > Firewall Policy. Configure policies as desired.
4. Configure a static route to the APIC FW_Svc_OneArm BD GW IP address:
a. Go to Network > Static Routes.

b. Click Create New.
c. Set Destination to Subnet, and leave the IP address and subnet mask as 0.0.0.0/0.0.0.0.
d. Inthe Gateway Address field, enter the APIC FW_Svc_OneArm BD GW IP address, which is 172.16.1.1.
e. From the Interface dropdown list, select vilan400.
f. Save the configuration.
¢ Edit | T Clor Delete | | Search Q
0.0.0.0/0 172.16.1.1 & vlan400 @ Enabled

5. Goto Log & Report > Forward Traffic. Confirm that you can view the Web and Application EPG traffic, indicating that
it is redirected to the FortiGate for inspection.

2 & | © AddFilter [5- [0Details [B
Date/Time ? Source Device Destination Application Name Result Polic
32 minutes ago 100.1.11 @ 00:50:56:04:01:c8 100211 ¥ 3.19kB/3.19kB Allow_All (1)
32 minutes ago 100211 @@ 00:50:56:b4:37:ab 100.1.11 ¥ 168B/168B Allow_All (1)
32 minutes ago 100111 B3 00:50:56:b4:01:c8 10.02.11 v 168B/168B Allow_All (1)
33 minutes ago 100.2.11 @0 00:50:56:b4:37:ab 100.1.11 v 244kB/2.44kB Allow_All (1)

6. Run the following commands in the CLI to configure FGCP and FGSP for cluster1:
config system ha
set group-id 112
set group-name "fortinetll2"
set mode a-p
set pass ENC 6v7bvuVAmnjUK8GLToPP4ctg9GdgRH37cZ01WEMbJzBTXg53bc8KF1COQFHk9AEZen695Q
set hbdev "ha" 512
set session-pickup enable
set session-pickup-connectionless enable
set session-pickup-expectation enable
set ha-mgmt-status enable
config ha-mgmt-status enable
edit 1
set interface "mgmt"

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.



HA on Cisco ACl using FGCP over FGSP

set gateway 192.168.139.254
next
end
set override disable
set ha-direct enable
end
config system cluster-sync
edit 5
set peerip 172.16.88.2
set syncvd "PBR"
next
end
config system standalone-cluster
set standalone-group-id 112
set session-sync-dev "port3"
end

14

A\,

connectionissetto available, the configuration may have issues.

‘q‘ By default, FortiOS sets 1ayer2-connectiontounavailable.If layer2-

7. Run the following commands in the CLI to configure FGCP and FGSP for cluster2:
config system ha
set group-id 112
set group-name "fortinetl112112"
set mode a-p

set pass ENC bhU6+uYFf7IpqOirYnFWOMhGxbpJkXY8bdHWEg906x2Wg+IFId6ZEJUGge2Wlots+g==

set hbdev "ha" 512
set session-pickup enable
set session-pickup-connectionless enable
set session-pickup-expectation enable
set ha-mgmt-status enable
config ha-mgmt-status enable
edit 1
set interface "mgmt"
set gateway 192.168.139.254
next
end
set override disable
set ha-direct enable

end
config system cluster-sync
edit 5
set peerip 172.16.88.2
set syncvd "PBR"
next
end

config system standalone-cluster
set standalone-group-id 112
set group-member-id 1
set session-sync-dev "porté6"
end

FortiOS Cisco ACI Administration Guide

Fortinet Technologies Inc.



HA on Cisco ACl using FGCP over FGSP 15

\
\q, By default, FortiOS sets layer2-connectiontounavailable.If layer2-
- connectionissetto available, the configuration may have issues.

8. Todebug cluster1, you can run the following commands. The screenshot shows the expected output of each
command:

a. diagnose system ha status
HA information
Statistics I
traffic.local = s:@ p:1198673 b:436792155
traffic.total s:8 p:1198676 b:436798922
activity.ha_id_changes = 3
activity.fdb = c:8 q:@

Model=1868, Mode=2 Group=112 Debug=0
nvcluster=1, ses_pickup=1, delay=0

[Debug_Zone HA information]

HA group member information: is_manage_primary=1.

FG18E1TB20900659 : Primary, serialno_pri , usr_priority=128, hostname=FG11@1E-1
FG1B8E1TB28900658 : Secondary, serialno_prio=1, usr_priority=128, hostname=FG1181E-2

[Kernel HA information]

vcluster 1, state=work, primary_ip=169.254.0.1, primary_id=0:
FG1BE1TB28980659 : Primary, ha_prio/o_ha_prio=8/8
FG18E1TB26900658 : Secondary, ha_prio/o_ha_prio=1/1

b. diagnose system ha standalone-peers
Group=112, ID=6
Detected-peers=1
Kernel standalone-peers: num=1.
peer@: vfid=@, peerip:port = 172.16.88.2:708, standalone_id=1
session-type: send=8, recv=595
packet-type: send=8, recv=80
Kernel standalone dev_base:
standalone_id=8:
phyindex=8: mac=e@: 191: linkfail=1
phyindex=1: mac=e@: :01: linkfail=1
phyindex=2: mac=e8 : linkfail=1
! mac=e@ H linkfail=1

C. diagnose system ha session-sync-dev

HA sessync ports: 1
port3 connected: HA connected, Standalone connected

HB pkts: rx=449e, tx=2284
SES pkts: rx=762, tx=235

9. Todebug cluster2, you can run the following commands. The screenshot shows the expected output of each
command:

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.



HA on Cisco ACl using FGCP over FGSP 16

a. diagnose system ha status
HA information
Statistics
traffic.local = s:0 p:181310 b:39959406
traffic.total = s:B8 p:184828 b:48312857
activity.ha_id_changes = 2
activity.fdb = c:8 q:0

Model=10608, Mode=2 Group=112 Debug=86
nvcluster=1, ses_pickup=1, delay=0

[Debug_Zone HA information]

HA group member information: is_manage_primary=1.

FG1BE1TB20900643 : Primary, serialno_prio=@, usr_priority=128, hostname=FG1101E-3
FG18E1TB26960230 : Secondary, serialno_prio=1, usr_priority=128, hostname=FG1101E-4

[Kernel HA information]

vcluster 1, state=work, primary_ip=169.254.0.1, primary_id=@:
FG18E1TB26960643 : Primary, ha_prio/o_ha_prio=8/80
FG10E1TB26900230 : Secondary, ha_prio/o_ha_prio=1/1

b. diagnose system ha standalone-peers
Group=112, ID=1
Detected-peers=1
Kernel standalone-peers: num=1.
peer@: vfid=8, peerip:port = 172.16.88.1:788, standalone_id=8
session-type: send=8, recv=0
packet-type: send=8, recv=8
Kernel standalone dev_base:
standalone_id=8:
phyindex=8: mac=60:89:8f:89:70: linkfail=1
phyindex=1: mac=e0:23:ff:01:86: linkfail=1
: mac=08:89:8f:089:70: linkfail=1
! mac=00:09:07:09:70: linkfail=1
I mac=08:89:87:89:70: linkfail=1
phyindex=5: mac=68:89:8f:09:708: linkfail=1

C. diagnose system ha session-sync-dev

HA sessync ports: 1
port6é connected: HA connected, Standalone connected

HB pkts: rx=4985, tx=2380
SES pkts: rx=145, tx=861

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.



SDN Connector integration with Cisco ACI

Al
‘Q' Fortinet Device Package for Cisco ACl is being deprecated. Use an SDN connector that this
- document describes as a replacement.

Off-the-box connector VM

You can use Cisco ACI (Application Centric Infrastructure) SDN connectors in dynamic firewall addresses.

The Fortinet SDN Connector for Cisco ACl is a standalone connector that connects to SDN controllers within Cisco ACI.
You must configure a connection to the Fortinet SDN connector in FortiOS to query the dynamic addresses.

Configuring the Cisco ACI connector in FortiOS

See the FortiOS Administration Guide.

Configuring VDOM and SDN connector - example

SDN Connector is the Fortinet response to integrate various SDN solutions with FortiGate as well as FortiManager
products. The SDN Connector serves as a gateway bridging SDN controllers and Fortinet devices including FortiGate
and FortiManager. The SDN Connector registers itself to the Cisco ACI SDN controller, polls interested objects, and
translates them into address objects. The translated address objects and associated endpoints are populated to the
FortiGate/FortiManager that are interested in these objects.

The following provides an example of configuring VDOM and SDN Connector. This example uses SDN Connector 1.1.3.

Overview

Components

The following diagram illustrates the relationship between the components of the SDN Connector:
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FortiManager

The following diagram illustrates the topology when using SDN Connector with FortiManager:
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4 . } N
Cisco ACI fabric SDN controllers

~
J

FortiGate FortiManager

Licensing
SDN Connector is available free of charge for Fortinet customers. You must ensure that you register your

FortiGate/FortiManager with FortiCare on Fortinet Customer Service & Support.

Hardware requirements
If you plan to instantiate a large number of virtual machines (VMs) in your SDN Connector environment, ensure that you
size the host VM or server appropriately. The following recommendations represent the minimum sizing numbers:

o Memory: 4 GB
» CPU:2vCPU
« Disk: 20-50 GB
e VNICs: 1

Terminology

The following defines some terms used in this guide:

ACI Cisco Application Centric Infrastructure

APIC Cisco Application Policy Infrastructure Controller
BD Bridge domain

EPG Endpoint group

VDOM Virtual domain

SDN Software-defined network

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.
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Supported new features

SDN Connector 1.1 supports the Nuage and Cisco ACI platforms. This guide is written for the Cisco ACI platform.

Supported Fortinet products

All physical and virtual FortiGate products that support the Fortinet Security Fabric are compatible with SDN Connector.

FortiManager-VM has also been qualified.

Firmware versions

SDN Connector 1.1 is compatible with the following FortiOS versions:

e 6.2.0 and later versions
« 6.05

Prerequisites

The following prerequisites must be met before deploying SDN Connector with Cisco ACI Connector:

» Cisco-side prerequisites on page 20

o FortiGate-side prerquisites on page 20

« FortiManager-side prerequisites on page 21
« SDN Connector prerequisites on page 21

o Cisco ACIl deployment on page 28

Cisco-side prerequisites

Before you can successfully deploy SDN Connector, a number of prerequisites must be satisfied within the Cisco
environment. A Cisco ACI 3.0 or later environment must be in place. Within Cisco, the following configurations must be
completed before SDN Connector can pull objects:

» Creation of Access Policies configuration under the Fabric menu
« Creation of any needed tenant(s)

o Creation of network(s) including BD

» Creation of application profile(s)

o Creation of EPG(s)

» Creation of contract(s)

o Create BG/OSPF L30ut (only if BGP/OSPF is required)

For details, consult the Cisco APIC deployment guide.

FortiGate-side prerquisites

Before you can successfully deploy SDN Connector, a number of prerequisites must be satisfied on the FortiGate:

1. Configure the administrator username and password.
2. Enable HTTP/HTTPS on the management port.
3. Configure the management port's IP address.

FortiOS Cisco ACI Administration Guide Fortinet Technologies Inc.
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4. Enable VDOM-Admin globally.
5. Configure port-group if needed.

FortiManager-side prerequisites

Before you can successfully deploy SDN Connector, a number of prerequisites must be satisfied on FortiManager:

1. Configure the administrator username and password.
2. Enable HTTP/HTTPS on the management port.

3. Configure the management port's IP address.

4. Register the FortiGate with FortiManager.

SDN Connector prerequisites

Before you can successfully deploy SDN Connector, you must complete a number of tasks on the SDN Connector:

Installing the SDN Connector

1. SDN Connector supports VMware vSphere, KVM, and Microsoft Hyper-V as deployment environments. Download
the connector package:

a. Onthe Customer Service & Support site, go to Download > Firmware Images.
b. From the Select Product dropdown list, select FortiSDNConnector.

c. Onthe Download tab, goto v1.00 > v1.1.3.

d. Download the appropriate file based on your hypervisor platform:

KVM sdn-connector-1.1.3.img
Hyper-V sdn-connector-1.1.3.vhd
VMware vSphere sdn-connector-1.1.3.zip

2. This example shows the installation process for vSphere client. Download sdn-connector.ovf. In vSphere Client, go

to File > Deploy OVF Template.

(5] VCENTER-VMLAB - vSphere Client
File | Edit View Inventory Administra

New 13

Deploy OVF Template... |
Export »

Report 3
Browse VA Marketplace...

rint Maps v

Exit

3. Inthe Deploy OVF Template dialog, enter the SDN Connector image file path in the Deploy from a file or URL field.
Click Next.
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[ Deploy OVE Template [E=EE)

Source
Select the source location

Source
QVE Template Details
Name and Location

a Deploy from a file or URL.
Ready to Complete
brnector-1-0-0-+c2-test2\sdn-connector-1-0-0-rc2-testZ.ovi g [0

Enter a URL to download and install the OVF package from the Intermet, or
specify a location accessible from your computer, such as a local hard drive, a
network share, or a CD/DVD drive.

o | = =1

Cancel |

4. The dialog displays the SDN Connector version, download size, and size on disk. Click Next.
r@ Deploy OVF Template = | (5 [ |

OVF Template Details
Verify OVF template detais,

Product: sdn-connector-1-0-0-rc2-test2

Ready to Complete

Download size: 617.2M8

Size on disk: 16 GB (thin provisioned)
3.0 GB (thick provisioned)

Description:

Help <Back | Next > I

Cancel

FortiOS Cisco ACI Administration Guide
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5. Enter the VM name, select the location, then click Next.

(&) Deploy OVF Template

(=] e

Name and Location
Specify a name and location for the deployed template

Source Name:

QVF Template Details '—__. —connector-1-0-0-rc2-test)]

Hame and Location
Storage

Ready to Complete

The name can contain up to 80 characters and it must be unique within the inventory folder.

Help I

< Back | Next > I Cancel |

6. Choose the destination storage for the VM files, then click Next.

@ Deploy OVF Template [= B ]
Storage
Where do you want to store the virtual machine files?
Select a destination storage for the virtual machine fles:
Name | Drive Type Capacity | Provisioned Free | Type Thin Pro+
@ datastorer Non-SD 2252568 3143268 43.98GB VMFSS  Supporte
i# LoclDisf®  Non-SD 18278 14678 108TB VMFSS  Suppore
Ready to (Z‘“JIL:'L‘
|
] 0 = »
Ho
|
Name Drive Type | Capadity | Provisioned Free | Type [ Thin Provi

m b

||| o

FortiOS Cisco ACI Administration Guide
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7. The dialog displays the datastore name and amount of available space. Select Thin Provision, then click Next.

(5) Deploy OVF Template

(= [ ]

Disk Format
In which format do you want to store the virtual disks?

d Locatio

Available space (GB): 1104.6

& Thick Provision Lazy Zeroed
" Thick Provision Eager Zeroed
€ Thin Provision

Source Datastore: [k e
mplate Details

Help

< Back |

Next > | Cancel I

8. Networks used in this OVF template should map to networks in your inventory. Choose the destination network for

network mapping, then click Next.

(&) Deploy OVF Template

[ESYECH==)

Network Mapping
What networks should the deployed template use?

Map the networks used in this OVF template to networks in your inventory

Source Networks
MGMT

Desaiption:

DestinationNetworks
VM Network

The MGMT network

< Back | Next > I Cancel
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9. The dialog displays all previously configured options. To edit an option, click Back. If ready to deploy, click Finish.
(@ Deploy OVF Template [

Ready to Complete

Are these the options you want to use?

When you dick Finish, the deployment task will be started.
Deployment setfings:

OVFfile: C:\Users\zpniu\work\sdn-connector-1-0-0-re2-test?isdn-c..
Download size: 617.2 MB

Size ondisk: 3.068B

Name: sdn-connector-1-0-0-rc2test2

Host/Cluster; esx-243,

Datastore: LocalDiskZT8

Disk provisioning: Thick Provision Lazy Zeroed

Network Mapping: "MGMT"to "VM Network”

' Power on after deployment

Help < Back | Finish I Cancel

Initializing the SDN Connector

1. After deploying the OVF template, turn on the VM and go to the Console tab. Once the SDN Connector boots up,
the system displays the following GUI dialog for configuration. Press Enter to proceed to the Network Interface
Configuration wizard.

ensaz Link encap:Ethernet HWaddr 00:0c:29:00:17:6c

t https://<IP Address> for further configuration
Is'set

—— <ancel>

The Network Interface Configuration wizard provides DHCP and static IP configuration options.

Select address source

= Dynamic IP

static Static IP

<Cancel»

When the VM receives the IP address from the DHCP server, the system shows this success dialog. The dialog
shows the SDN Connector IP address and gateway information.

25
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Network configuration completed successfully!

Internet Systems Consortium DHCP Client 4.3.3

Copyright 2004-2015 Internet Systems Consortium.

All rights reserwved.

For info, please wisit https://www.isc.orgssoftware/dhcps

Listening on LPF/ens32/00:0c:29:Be:aa:d7

Sending on LPFsens32/,00:0c:29:8e:aa:d7

Sending on Socket/fallback

DHCPDISCOVER on ens32 to 255.255.255.255 port 67 interval 3
(x1d=0x30ea567h)

DHCPREGUEST of 10.160.13.112 on ens32 to 255.255.255.255% port 67
(xid=0x7h56ea30)

DHCPOFFER of 10.160.13.112 from 10.160.13.1

DHCPACK of 10.160.13.112 from 10.160.13.1

bound to 10.160.13.112 -- renewal in 290399 seconds.

When the VM is configured with a static IP address, the system shows this success dialog.

Metwark configuration completed
successfully!

2. To change the network configuration, click OK and return to the wizard to restart the setup flow.
3. Using a web browser, go to https://<SDN connector IP address>.

A

4. Loginto the system with the default username and password, which are admin@sdn-connector.local and
fortinet123, respectively. When you first log in, the GUI prompts you to change the password.
]

Change Web GUI Password

Configuring the SDN Connector

The SDN Connector GUI has several web controls. It is a single-page web application.

To restart the service, click Restart Service. The system displays a dialog asking you to restart the connector service.

Going to restart in 10s. Are you sure?

To change the password, click Change Password.
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Change Web GUI Password

To change the configuration click Configuration.

Fortinet Fabric Connector E::

- Upar

_ SDN Controller Type Fabric Connector IP
Configuration

[ . v] I\rr.s.lm:.v

Running Status
APIC HostIP Fabric Connector Username

[ i - - ]
10.105.152.11, 10.105.152.12, 10.105.152.13 ‘ admin

Download Log

APIC Username IChange Fabric Connector Password
= | [

APIC Password

Log Level

[ms

The Configuration page consists of the following fields:

Option Description

APIC Host/IP You can enter multiple APIC IP addresses and/or FQDNs. Ensure that you
separate each entry with a comma.

APIC Username Enter the Cisco ACI username as obtained from the ACI administrator.
APIC Password Enter the Cisco ACI password as obtained from the ACI administrator.
Fabric Connector Username Enter the FortiGate/FortiManager username used to log into the Fortinet SDN

connector. The default username is admin.

Change Fabric Connector Enter the FortiGate/FortiManager password used to log into the Fortinet SDN
Password connector. The default password is fortinet123.

To upgrade the service, go to the SDN Connector homepage, then click UpgradeService on the banner. A dialog shows

the upgrade progress. Once the upgrade is finished, the dialog prompts “Upgraded Successfully! Going to refresh in
10s” and the GUI refreshes automatically. This allows patch upgrade for SDN Connector.

Upgrade SDN Connector Software

Select File(tar.gz or whi)
Upload

The following displays sample output objects pulled from Cisco ACI:
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Fortinet SON Connector === e e e e I Lot

[(1p°"1.1.1.107 "mac
[ e RRR T

[1p""4.11 10 "ma

[{99°:"10.26.10.3" “mac"*54:7F-EE:26:50:8C 1

Click Running Status to verify the status. When the signal icons are green, this indicates the connection between the
SDN controller and SDN connector has been established.

Cisco ACI deployment

This section describes steps to create endpoint objects within ACI that SDN Connector can extract from. The steps
include the following:

1. Create atenant (Tenant1) and VRF (vrf1).

2. Create BDs (app and web).

3. Create EPGs (app and web).

4. Create an L4-L7 device (FGT1).

5. Create a service graph template (Template1).
6. Deploy service graph between web and app.

To create a tenant and VRF:

1. InCisco APIC, go to Tenants > Add Tenant.
2. Create atenant and VRF as shown below. In the example below, the tenant is named "Tenant1", and the VRF is
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named "vrf1".

alia]n
cisco

APIC

System Tenants Fabric Virtual Networking

L4-L7 Services

Admin Operations

29

Apps

ALLTENANTS | AddTenant | TenantSearch: QENEEEECE

- Create Tenant |

Tenant Demol
I > CP Quick Start
~ B8 Tenant Demot

> Application Profiles
> Networking
> Contracts
> Policies
>

Services

To create a BD (app and web):

1. Create the app BD:

Specify tenant details

ool

| Name: | Tenant1
Alias: |
Description: | optional
blo
Tags: - bli
s separ i
GUID! +
Provider GUID Account Name
) an
Monitoring Policy: | select a value ~

Security Domains

Name

Description

VRF Name ‘w' ]

Take me to this tenant when | click finist

a. Goto Tenants > Tenant 1 > Networking > Bridge Domains.
b. Create the app BD as shown. In the Name field, enter App. From the VRF dropdown list, select vrf1. Click Next.

I [in
cisco  APIC

System Fabric Virtual Networking

ALLTENANTS | AddTenant | TenantSearch: SRy

Tenant Tenant]

> O Quick Start
~ Bl Tenant Tenant1

> [ Application Profiles

Net

I Bridge Domains
> VRFs

> External Bridged Networks
> External Routed Networks
> Dot1Q Tunnels

> Contracts

> Policies

> Services

FortiOS Cisco ACI Administration Guide

L4-L7 Services Admin

Operations

Create Bridge Domain

Apps

o

3. Advanced/ Troubleshaoting

STEP 1 > Main
Specify Bridge Domain for the VRF
[ = |
Alias: |
Description: |optional
Tags: o

[wm o |

Forwarding

Endpoint Retention Policy:

IGMP Snocp Policy:

Optimize ~

select a value .

only applies to local L2 L3 and
ema e

select a value ~

=T D

Previous
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c. Configure the other parameters as required. Click Finish.
2. Define a subnet gateway for the app BD:
a. Ifyou are using policy base routing (PBR), this will be the gateway for the endpoints that belong to this BD. For
PBR configuration, consult the Cisco configuration guide. If you are not using PBR, the endpoint gateway will

be the interfaces on the FortiGate. In our example, we are using the FortiGate interface as the gateway for the
endpoints. Go to the newly created BD app, then click Subnets.

b. Create the subnet and enter the gateway IP address as shown.

csco  APIC

System Tenants Fabric Virtual Networking L4-L7 Services Admin Operations Apps

ALLTENANTS | AddTenant | TenantSearch: | Temantl | common | Demol | Demo3 | infra

Tenant Tenant1 @ = © | Subnets

> C» Quick Sta

P Create Subnet 00

> Application Profiles Specify the Subnet Identity

Gateway IP: [192.168.1.1/24
Networking ateway IP: [192.168.1.1/24] |
e

mask e a
ate a
s pei) Treat as virtual IP address: [ ]
~ App Make this IP address primary: []
> [l DHCP Relay Labels Scope: [ Private to Vi

O Ad
L4-L7 Service Parameters

[ Sharec
Description: | optional

> [ ND Proxy Subnets

> VRFs Subnet Control @
> External Bridged Networks [ No Default SVI Gateway
B O Querier 1P
> External Routed Networks
L3 Out for Route Profile: | select a val o
> [ Dot1Q Tunnels
Route Profile: [ e -

e - ]

c. Click Submit.
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3. Create the web BD:
a. Goto Tenants > Tenant 1> Networking > Bridge Domains.

b. Create the web BD as shown. In the Name field, enter web. From the VRF dropdown list, select vrf1. Click Next.
alvaln
cisco  APIC

System Fabric

Virtual Netwarking L4-L7 Services Admin Operations Apps

Create Bridge Domain [2Tx]
Tenant Tenant1 m (B .
STEP 1 > Main duancsaliiossos
>Cra i

Alias:
I Description
3 Tags
L4-L7 Servi arameters
> W Subnets |
VRF: 4] ~ |
> [ ND Proxy Subnets &
Forwarding. | Optimize ~
VRFs

Endpoint Retention Policy: |select & value

IGMP Snoep Policy: |select a value

c. Configure the other parameters as required. Click Finish.
4. Define a subnet gateway for the web BD:

a. Ifyou are using policy base routing (PBR), this will be the gateway for the endpoints that belong to this BD. For

PBR configuration, consult the Cisco configuration guide. If you are not using PBR, the endpoint gateway will

be the interfaces on the FortiGate. In our example, we are using the FortiGate interface as the gateway for the
endpoints. Go to the newly created BD app, then click Subnets.
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b. Create the subnet and enter the gateway IP address as shown.

Tt APIC

System Tenants Fabric Virtual Networking L4-L7 Services Admin

ALL TENANTS | Add Tenant |Ter|antSeamh:| Tenant1 | common |

Operations Apps

Demol | Demo3 | infra

32

Tenant Tenant1

> C» Quick Start
~ B Tenant Tenant1

> [l Application Profiles

~ [ Networking

~ [ Bridge Domains
> App

> DHCP Relay Labels

L4-L7 Service Parameters

| ===

> [ ND Proxy Subnets

> VRFs
> External Bridged Networks
> External Routed Networks
> Dot1Q Tunnels

> W contracts

> Policies

> Services

c. Click Submit.

To create EPGs:

1. Create an application profile for the EPGs:
a. Goto Tenants > Tenant 1 > Create Application Profile.

i
cisco

APIC

System Fabric Virtual Networking L4-L7 Se

ALLTENANTS | AddTenant | TenantSearch:

Tenant Tenant

> C» Quick Start
~ ﬁ Tenant Tenant1

A
I Create Application Profie

~ Networkmng
~ [l Bridge Domains

> App

> @ web

> VRFs

FortiOS Cisco ACI Administration Guide

o =0
Create Subnet

Specify the Subnet Identity

Treat as virtual IP address: []

Subnets

8.2.1/24

Gateway IP: [192

Make this IP address primary: []

Scope: [ Private to VRF
[ Advertised Externally
[ shared between VRFs

Description: |optional

Subnet Control @
[ No Default SVI Gateway
O querier P

o0

Een fi
tea

|
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b. Configure as shown, then click Submit.

csco  APIC

System Tenants Fabric Virtual Networking L4-L7 Services Admin Operations Apps
ALLTENANTS | AddTenant | TenantSearch: (IR tcal | Tersmt! | common | Demol | Demo3 |

Lt el |C|eate Application Profile [2]X]

Specify Tenant Application Profile

> O Quick Start

~ HH Tenant Tenantt Name: [A|

I Application Profiles Alias

~ [l Networking

Description: | optional
~ [l Bridge Domains
> @ App. Tage =

> @ web e

Monitoring Policy: |select a value ~

EPGs

arated by comma
> [ VRFs
> External Bridged MNetworks

> External Routed Networks

Name Alias BD Domain Switching Static Path Static Path Provided Consumed

Dot1Q Tunnels
> 0t1Q Tunnels Mode VLAN Contract Contract

> Contracts
2 Policies

> Services

=D

2. Create the app EPG:
a. Goto Tenants > Tenant 1 > Application Profiles > AP > Application EPGS > Create Application EPG. Do not
use | in the EPG name.
b. Configure as shown, selecting the web BD.
c. Click Finish.

csco  APIC

System Tenants Fabric Virtual Networking L4-L7 Seryicac Admin 0 i Annc
ALLTENANTS | AddTenant | TenantSearch: [itR R Create Application EPG | 00
y 1. Identity
STEP 1 > Identity
Tenant Tenant1
Specify the EPG Identity
> ¥ Quick Start
| Mame: |app -
< [ Tenant Tenant1 -
Alias:

~ [ Application Profiles

~ @ ap

I Application EPGs

Description: [optional

Tags: ~

SR USeq EPGs antes

- Contract Exception Tag:
L4-L7 Service Parameters 3 9

QoS class: | Unspecified
~ Networking £ =
Custom QoS: | select a value ~
~ Bridge Domains
Data-Plane Policer: | select a value ~

> [l External Bridged Networks
Flood on Encapsulation: Enabled
> [l External Routed Networks
Bridge Domain: | N8 ~ @ |

> [ Dot1Q Tunnels
Monitoring Policy: | select a value [~
> [l Contracts
FHS Trust Control Policy: |select a value ~
> [l Policies

Associate ta VM Domain Profiles: []
> Esss Statically Link with Leaves/Paths: []
EPG Contract Master: }

Previous Cancel @

Application EPGs
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3. Configure tag(s) for the app EPG if desired.

il
cisco

APIC

System Tenants Fabric Virtual Networking L4-L7 Services Admin

ALLTENANTS | AddTenant | TenantSearch:

Operations

34

admin

Apps

| Temant! | common | Demol | Demo3 | infra

Tenant Tenant1

> O Quick Start

[ IS

Y E—

~ [ Appication Profiles

v @ ap

« [ Application EPGs
I > 8 app

o web

Domains (VMs and Bare-Metals)
> EPG Members
> Static Ports
Static Leafs
> Fibre Channel (Paths)
Contracts
‘Static Endpoint
> Subnets
L4-L7 Virtual IPs
L4-L7 IP Address Pool
L4-L7 Service Parameters
> [ uSeq £PGs
L4-L7 Senice Parameters
v [ Networking
[l Eridge Domains
~ @ Ao
> DHCP Relay Labels
L4-L7 Service Parameters

> [ Subrets M

4. Map endpoint VMs to the app EPG:

EPG - app

Operational  Stats

Summary [ Polic

Properties
Name: app
Alias:

Description: [optional

Tags: |cEpINY v

Global Alias:
uSeg EPG: false
peTag(sclass): 49154
Contract Exception Tag:
Qos class: [Unspecified -

Custom QoS

value -

Data-Plane Policer:

Flood on Encapsulation: SEREELIEL] Enabled

Configuration Status: applied

ta value -

Configuration Issues:

Label Match Criteria: |AtleastOne -

Show Usage

a. Goto Tenants > Tenant1 > Application Profiles > AP > Application EPGs > app, then right-click Domains (VMs
and Bare-Metals). Select Add VMM Domain Association.

alvaln
cisco

APIC

System Fabric Virtual Networking

Add Tenant | Tenant Search: REt

Tenant Tenant1
> CP Quick Start
~ ﬁ Tenant Tenant1
~ [ Application Profiles
~ @ ae
~ [l Application EPGs
~ % app
I Domains (VMs and Bare-Mstals)
N oG Membere Add VMM Domain AssoCiation
5 Static Ports Add Physical Domain Association
Static Leafs Add L2 External Domain Assaciation

> Fibre Channel (Paths) Add Fibre Channel Domain Association

Contracts
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b. Configure the VMM domain association as shown. Click Submit.

cisco  APIC

System Tenants Fabric Virtual Networking L4-L7 Services Admin Operations Apps

ALLTENANTS | AddTenant | TenantSearch:

Tenant Tenant] @ = © | Domains (VMs and Bare-Metals)
> C» Quick Start -

o ﬁ Tenant Tenant1

|Add VMM Domain Association |

Choose the VMM domain to assoc

~ [ Application Profiles

~ @ ap

~ [ Application EPGs

| VMM Domain Profile: | acivs

e nmediz
> % — Deploy Immediacy: | Immediate ‘On Demand
I Domains (WMs and Bare-Metals) Resolution Immediacy: JERTELEE On Demand Pre-provision
> EPG Members Delimiter:
> Static Ports Allow Micro-Segmentation: []
Static Leafs VLAN Mode: m Static
> Fibre Channel (Paths)
Netiow Encbie
Contracts
Allow Promiscuaus: | Reject ~
Static Endpoint
Forged Transmits: | Reject ~
> Subnets
MAC Changss: |Reject ~

L4-L7 Virtual IPs

L4-L7 IP Address Pool

L4-L7 Service Parameters
> 09 web

> [ uSeg EPGs

L4-L7 Service Parameters

> Networkina

c. Inthe hypervisor, select the configured VMM domain association under the Network label.

B [y 10.105.152.8 ~
= SDHVC
= fl MuageCluster
@ 10.105.152.51

Summary W L N

&Events Alarms ' Console ' Permissions ' Maps

{1 FortADC-VM-152105
G FortADC-VM-152106
([ Fortigate-VM_152103

(3 Gabriel

sdnvc

(5 WebClient

FortiOS Cisco ACI Administration Guide

com.vmware.vd. ..
Notes:

10.105.152.62 e | [Resources
() Centos7 (1) Guest 0S: Microsoft Windows 7 (§4-bi I 1
(1 Cluster1DB2 M Version: 8 (&) App_pcl - Virtual Machine Properties - ul X
(3 Cluster1web3 CPU: 2vCPu
&) DBTest Memory: 2058 VB Hardware | Options | Resources | vServices | Virtuzl Machine Version: 8

DBU2 " Overhead: ~Device Status
% DaL22 Emory Ciemea I~ Show All Devices Add... Remove ¥ Comected
@ Fortigate-yM_152144 VMware Tools: /A Running (Out-of-date) " c I

- ) onnect at power on
s Fortigate-YM_152145 1P Addresses: 2.1.1.101 Hardware | Summary |
@ GabrielUB MR Memory 4096 MB Adapter Type
(s Gabrielus_v17 DNS Name: Outside-PC i crus 2 e TS
{3 sdn-connector_15297_devil EVC Mode: NfA Video card Video card SR
() StapleVmuareCannector State: Powered On S VML device Deprecated MAC Address
: —MAC A
3 Webpc Host: 10.105.152.30 @ scsicontroller 0 LSl Logic 545
2B 5-100253-::‘%-3“ Actve Tasks: & coovervet Client Devics
5 1401234 61 vsphere HA Protection: @ Nfa B & Hard disk1 Virtual Disk lanual
& J012345 EB Network adapter 2 (edite... Tenant1|AP[app (ac... |
Commands ~DirectPath 1/0
) 5012345
O Status: Inactive @
Shut Down Guest
To activate DirectPath I/0, go to the Resources tab and

& pB2-L2 00 suspend select Memory Settings to reserve all guest memory.
) DBSRV2 Y Restart Guest
& Devsever2 ~Network Connection
(3 Fortigate-yM_152142 3 Edtsettings Network label:
{3 Fortigate-VM_152143 & Open Console

Gabriel2 i
(3 Gabriel (B8 Migrate Port: 928
1 RayUbuntu N )
(T Weboo1 £ Clone to New Virtual Machine Switch to advanced settings

=] @ 10.105.152.31

3 Arp3 Annotations
(T3 Demo3Web
5 DemoApp Clusterl
& Fortap2012 lusterInvarian...

oK Cancel
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5. Repeat step b to create the web EPG, selecting the web BD instead of the app BD. Do not use | in the EPG name.

b APIC

System

Fabric Virtual Networking

ALLTENANTS | AddTenant | TenantSearch: EERVEEESS

L4-L7 Serv

Create Application EPG

Tenant Tenant1

> O Quick Start

hd ﬁ Tenant Tenant1

~ T Application Profiles

v @ ap

I ~ [l Application EPGs

La-L7 Service Parameters
Networking

Bridge Domains

> @ oo

> @ web
> [l VRFs
> External Bridged Networks
> External Routed Networks
> Dot1Q Tunnels

> Contracts
> Policies

> Services

STEP 1 > Identity

Specify the EPG Identit
Name: |web
Alias
Description: | optional
Tags: ~
o i "
Contract Exception Tag
QoS class: | Unspecified ~
Custom QoS: | select a value ~
Data-Plane Policer: |select a value -

Intra EPG Isolation

Preferred Group Member m Incluce
Fleod on Encapsulation Enabled

Monitoring Policy:

Biidge Domain: [T = §|
select a value %
select a value o

FHS Trust Control Policy

Assaciate to VM Domain Profiles: [

Statically Link with Leaves/Paths: []

EPG Confract Master:

6. If desired, create tag(s) for the web EPG.
7. Repeat step c to map endpoints to the web EPG.

To create an L4-L7 device:

Application EPGs

1. Goto Tenant > Tenant1 > Services > L4-L7 > Devices > Create L4-L7 Devices.
2. Ifusing unmanaged mode, ensure that the Managed checkbox is not selected.

FortiOS Cisco ACI Administration Guide
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3. Configure as shown, then click Finish.

APIC

cisco

System Fabric Virtual Netw

Create L4-L7 Devices

ALL TENANTS | > General

Select d
Tenant Tenant1 G

> % Quick Start

Add Tenant | Tenant Search: [ESISEEY IS 2]

Name:
~ B Tenant Tenam1

Service Type:
- Application Profiles
> @ ap Device Type:
> Networking Physical Domain
> [ Contracts View:
> [l Policies
~ Services Promiscuous Mode:
~ [ L4-L7 Context Aware:

Senvice Parameters Function Type:
> [l Senice Graph Templates

> [l Router configurations

> nction Profiles

imported Devices

> [ Devices Selection Policies
> [l Deployed Graph Instances
> [ Deployed Devices

> [l Device Managers

> [l Chassis

E inband Management Gonfiguration for L4-1

2 DNS Server Groups (Beta)

To create the service graph template:

Configure the service graph template.
Click Submit.

csco  APIC

package and V

1

Make sure this is unchecked
for Unmanaged mode

Device 1

Device Interfaces

Firewall - Name
ports
PHYSICAL [V (UET | porté.
FWDomain ~ @
@ Single Node © HA Node
© Cluster
Cluster
]
Cluster Interfaces:
Single
Name
provider

System

| AddTenant | TenantSei

| Create L4-L7 Service Graph Template |

Drag device clusters to create graph nodes.

37

o0

T
Path
Pod-1/Node-103/eth1/9
Pod-1/Node-103/eth1/10
v
Concrete Interfaces Encap

Device1/ports

Device 1/porté

Previous

Go to Tenant > Tenant1 > Services > L4-L7 > Service Graph Templates > Create L4-L7 Service Graph Template.

QQI

@ Create a New Graph

© Clone an Existing Graph

~ [l Application Profiles Tenant1 fFGT1

> @ ae F
> Netwaorking

> [l Contracts

> [l Policies

Service Parameters

I > [l Senvice Graph Templates

> [l Router configurations

> [ Function Profiles
~ [l Devices

> B rem
? mported Devices
> [ Devices Selection Policies
> [ Deployed Graph Instances
> [ Deployed Devices
> [ Device Managers
> [ Chassis

B inband Management Configure

> [l DNS Server Groups (Beta)

FortiOS Cisco ACI Administration Guide

Tenant Tenant1 Device Cluster Service Graph Name: | Template
> > Quick Start —— Graph Type:
~ [ Tenant Tenantt = avetypes pa——

Provider

FGT1

N1

FGT1 Information

Firewall: @ Routed

Route Redirect: []

© Transparent
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To deploy the service graph template between the web and app EPGs:

1. Deploy the service graph between the web and app EPGs:
a. Goto Tenant > Tenant1 > Services > L4-L7 > Service Graph Templates. Right-click Template1, then select

C.

Apply L4-L7 Service Graph Template.

csco  APIC

System RO Febric  VitualNetworking  L4-L7 Senvices  Admin  Operations  Apps

ALLTENANTS | AddTenant | TenantSearch: [EESORueeiRN | Torant! | common | Demol | Demo3 | infra

38

- XX

Tenant Tenant1 @ = ©  L4-L7 Service Graph Template - Template1
» O Quick star opology  Poliey  Fa
“H —
Applic
> @ ap Consumer Provider

> [l Networking

> [l Contracts a1

>
N1

FGT1 Information
Firewall: Routed

arameters
raph Templates
Route Redirect: false
ply L&-L7 Service Graph Template
Edit L4-L7 Service Graph Template
s
Delete

Remove Related Objects of Senice Graph Template

| Saveas

From the Consumer EPG / External Network dropdown list, select the web EPG.
From the Provider EPG / Internal Network dropdown list, select the app EPG.
Enter a contract name.

Click Next.

deh APIC

System [RCIEVSM  Fabic Vi |App|y L4-L7 Service Graph Template To EPGs
ALLTENANTS | AddTenant | Tenant Sef
STEP 1 > Contract

Tenant Tenant1 Config a Contract Between EPGs

= EPGs Information
> O Quick Ster

(2>

Networking

| Contract Name: [contract | \|
ects

N Filter (Allow Al Traffic):

raph Templates

I > © Tempiate

> [l Router configurations

> [l Function Profiles

Bl inband Management Gonfigur:

> [ DNS Server Groups (Beta)

Consumer EPG / External Network: [Tenant] /AP/epg-web <@ Provider EPG / Internal Network: | Tenant1/A/epg-ape M-I )
« B Tenant Tenant1
Application Profies
Contract Information
> @ ar Contract: @ Create A New Contract © Choose An Existing Contract Subject

Previous Cancel

f. From the Service Graph Template dropdown list, select the service graph template configured in step h.
g. Under FGT1 Information, configure the consumer connector as shown, selecting the web BD. Configure the

provider connector with the app BD.
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alvale
cisco  APIC ]
system [REUCRCE Fabic Vi |App|y L4-L7 Service Graph Template To EPGs | (2 1X]

ALLTENANTS | AddTenant | Tenant Se; 1. Contract 2. Graph |
STEP 2 > Graph o =
T TR Config a Service Graph

> C* Quick Start [Senvice. Graph Tenant] [Template1 L@
Template: |
~ Bf Tenant Tenant1
Consumer Provider
~ [ Application Profies
c P
e
FGT1
> [ Networking app
> [ Contracts
N1
FGT1 Information
Firewall: routed
Service Parameters Policy-based Routing: false
v [ Senvice Graph Templates Consumer Connector
| 5 @ Tempiatel Type: @ General © Route Peering
> Router configurations BD: | Tenant b | @@
> & Function Profiles
L3 Destination (VIP)
&b Cluster Interface: |consumer <@
> B Fomi
Provider Connector
B i ez Type: @ General ® Route Peering
> [l Devices Selection Policies 80: [FomantiiAn @
> [l Deployed Graph Instances B0 that carmiects th
: L3 Destination (VIP): [7]
> [l Deployed Devices )
Cluster Interface: | provider ~ @
> [l Device Managers

> [l Chassis
B inband Management Gonfigur:

> [ DNS Server Groups (Beta)

h. Click Finish. The service graph is deployed.

cisco  APIC

System Tenants Fabric Virtual Networking L4-L7 Services Admin Operations Apps

ALLTENANTS | AddTenant | Tenant Search:

@ = © | Deployed Graph Instances

> CF Quick Start

~ % Tenant Tenant1 Service Graph Contract Contained By State
~ [l Application Profiles Template1 contract1 Tenant Tenant1 applied
> @ np
> [ Networking

> Contracts

> Policies
~ Services
~ bl La-L7

Service Parameters

> W Service Graph Templates

> W Router configurations
> [l Function Profiles 1
> [ Devices
> mported Devices
> Devices Selection Policies
I ~ [l Deployed Graph Instances

> () contract1-Template1-Tenant1

> W Deployed Devices

2. Obtain the VLANs assigned to the interfaces. You will configure the corresponding VLANSs on the FortiGate side:

a. Goto Tenant> Tenant1 > Services > L4-L7 > Deployed Graph Instances > contract1-Template1-Tenant1 >
Function Node - N1.

39
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b. Under Function Connectors, note the VLANS listed for the consumer and provider in the Encap column.
Uets APIC wn @ O O

system [REROLl Fabic  Vitual Networking  L4-L7 Services  Admin  Operations  Apps

ALLTENANTS | AddTenant | TenantSearch: [INUSSRUeeSERRN | Terant! | common | Demol | Demo3 | infra

@ = © | Function Node - N1

> O» Quick Start Faults

16387

Deploying SDN Connector

SDN Connector works with standalone FortiGate as well as FortiManager. The below sections describe steps for
deploying FortiGate in standalone or managed mode with FortiManager:

» Deploying SDN Connector with FortiGate (standalone) on page 40

« Deploying SDN Connector with FortiManager on page 46

Deploying SDN Connector with FortiGate (standalone)

Deploying SDN Connector when using FortiGate in standalone mode consists of the following steps:

1. Create a VDOM.

2. Create VLAN interfaces.

3. Create static routes.

4. Configure a Fabric SDN Connector.

5. Create dynamic addresses.

6. Create policies using the dynamic address(es).

To create a VDOM:

—

In FortiOS, connect to the management VDOM.
Go to Global > System > VDOM and select Create New.
3. Enter a unique Name. VDOM names have the following restrictions:
e Only letters, numbers, "-", and "_" are allowed.
« No more than eleven characters are allowed.
» No spaces are allowed.
« VDOMSs cannot have the same names as interfaces, zones, switch interfaces, or other VDOMSs.
Enter a short and descriptive comment to identify this VDOM.
Select OK.

g

o
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To create VLAN interfaces:

1. Go to Network > Interfaces.
2. Click Create New > Interface.
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3. Configure an interface for each VLAN noted in the last step of Cisco ACI deployment on page 28. Ensure that the
VLAN mapped to the interface corresponds to the VLAN that ACI assigned during service graph deployment.

~= FortiGate 3700D FGT37D4615800597

@ Global v | New
& Dashboard >
" Interface Name | port5_vlan2767
X Security Fabric >
Alias
+ Network ~
Type VLAN -
Interfaces w
Interface ports -
DNS
VLANID 2767
System >
@ 5y Virtual Domain | & NYC -
B Policy & Objects >
& Security Profiles > | Tags
Ll Log & Report > Role o [Lan -
© Add Tag Category
Address

Addressing mode

IP/Network Mask 192.168.2.2/24
IPv6 Addressing mode DHCP
IPvé Address/Prefix =/0

Administrative Access

1Pv4 #| HTTPS | HTTP €
CAPWAP | SSH
RADIUS Accounting

IPvé Administrative Access HTTPS HTTP &
CAPWAP SSH

» DHCP Server

Networked Devices

Device Detection @
Active Scanning (B

FortiOS Cisco ACI Administration Guide

#| PING
SNMP
FortiTelemetry
PING
SNMP

FMG-Access
FT™M

FMG-Access
FTM

Cancel
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=73 FortiGate 3700D FGT37D4615800597

¥X Security Fabric >

& Network

@ Global v | New
@ Dashboard >

Interface Name porté_vlan2766
Alias

Type VLAN -
Interfaces

Interface porté -
DNS
VLANID 2766
£ Systs >
yetem Virtual Domain | & NYC -
B Policy & Objects >
@ Security Profiles | Tags
Ll Log & Report > Role e [Lan -

© Add Tag Category

Address

Addressing mode DHCP
IP/Network Mask 192.168.1.2/24
IPv6 Addressing mode DHCP
IPvé Address/Prefix =/0

Administrative Access

1Pv4 ¥ HTTPS ¥ HTTP @ ¥ PING "] FMG-Access
| CAPWAP ¢/ SSH L] SNMP L FT™M
|| RADIUS Accounting || FortiTelemetry

IPvé Administrative Access || HTTPS HTTP @ ) PING ] FMG-Access
| CAPWAP ] SSH [] SNMP ] FT™M

» DHCP Server

Networked Devices

Device Detection @©
Active Scanning (B

a

To create static routes:

Go to Network > Static Routes.
Click Create New.

Configure two static routes as shown below: one for each VLAN configured in the previous section.
& NYC T || 4 CreateNew~ | ¢ Edit [m Clone [ Delete

@ Dashboard ’ Destination Gateway

¥ Security Fabric 3 [Eipva(2)

& FortiView > |192.1682.0/24 192.168.2.1
+ Network ~ [192.168.1.0/24 192.168.1.1

Interfaces

Packet Capture
SD-WAN
Performance SLA
SD-WAN Rules

1
7

Static Routes W

Policy Routes

To configure an SDN connector:

1.

Go to Security Fabric > Fabric Connectors.

2. Click Create New.
3. Under SDN, select Application Centric Infrastructure (ACI).

FortiOS Cisco ACI Administration Guide

42

Fortinet Technologies Inc.



SDN Connector integration with Cisco ACI

4. Configure the SDN Connector, then click OK. The default port is 5671.

ortiGate 3700D FGT37D4615800597

@ Dashboard

%4 Security Fabric
Automation
Settings
Fabric Connectors

+ Network

L System

B Policy & Objects

& Security Profiles

il Log & Report

New Fabric Connector

SDN

Application
Centric
Infrastructure
(acr)

Connector Settings

Username | admin

Name SDNConnector
P 10.105.152.97

Port Use Default g1

Password | o..o..co.co‘ @&

Status @O

To create dynamic addresses:

1. Goto Policy & Objects > Addresses.
2. Click Create New > Address.

3. Configure a dynamic address for the app EPG. Ensure that the format for the endpoint group name is entered as
"Application Profile name|EPG name". This is case-sensitive. In Cisco ACI deployment on page 28, the application

profile was named "AP", and the EPGs were named "app" and "web". Therefore, the correct format is AP|app and
AP|web, as shown below.

ortiGate 3700D FGT37D4615800597
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@ Dashboard

S Security Fabric

i FortiView

+ Network

L System

B Policy & Objects
I1Pv4 Policy
IPv6 Policy
IPv4 Access Control List
IPv6 Access Control List
IPv4 DoS Policy
IPv6 DoS Policy
Addresses
Wildcard FQDN Addresses
Internet Service Database
Services

Schedules

New Address

Category IPvé Address

Name WebEPG

Color #  Change

Type Fabric Connector Address -

Fabric Connector Type
Tenant

Endpoint Group Name
Tag

Interface

Showin Address List @

Comments

Tags

Application Centric Infrastructure (A +
Tenantl

AP|web

TAG-100

O any -

© Add Tag Category

FortiOS Cisco ACI Administration Guide
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4. Repeat steps 2 and 3 to configure a dynamic address for the web EPG.

| & NYC | v NewAddress

@ Dashboard >
Categor =g |Pv6 Address
Security Fabric > gory -
Name AppEPG
i FortiView >
Color #  Change
+ Network > 8
Type Fabric Connector Address -
& System >
Fabric Connector Type Application Centric Infrastructure (A +
IB Policy & Objects v
Tenant Tenantl
IPva Policy .
Endpoint Group Name AP|app
1Pvé Policy
Tag [ TAG-200]
IPv4 Access Control List Interface O any -
IPvé Access Control List Show in Address List €@
i 0/255
IPv4 DoS Policy Comments )
IPv6 DoS Policy
Addresses 4 Tags
Wildcard FQDN © Add Tag Category
Addresses
Internet Service Database

Services Cancel

The following shows that the FortiOS and SDN Connector output regarding the web and app EPGs contain
corresponding information:

FGT37D4615800597 (NyC) # diag firewall dynamic 1ist
List all SDM dynamic addresses:

R(192.168

ID(55 T =
10(59) REF(1) ADDR(192.168
5 EDDR i)

a I g o

a Demo2. LongEPGName01234567890123456789012345678901234567890123456789012. *: ID(89) REF(1) ADDR(2.1.1.100)

aci.Demo2. AP | LongEPGName01234567890123456789012345678901234567890123456789012. *: 1D(102) REF(1) ADDR(Z.1.1.100)
aci.Demo2. AP2 | LONGEPGName01234567890123456789012345678901234567890123456789012. %: ID(152) REF(L)

a Demo2. LongEPGName01234567890123456789012345678901234567890123456789012. TAG-55: ID(162) REF(1)

aci.pemo2. *.*7 ID(194) REF(1) ADDR(1.1.1.10) ADDR(2.1.1.10) ADDR(2.1.1.100}

aci.Demo2. AP | LongEPGName01234567890123456789012345678901234567890123456789012. TAG-100: ID(214) REF(1)

't SDN Connector UpgradeService  RestartService  ChangePassword

Configuration
DN & TAGS Dynamic Address List Address Count If

RITTEED tn-Demoz/ap-AP/epg-appo1 i 22222 !

- in-Demo2/ap-AP/epg- ['number_2000"] [(ip":"2.1.1.100","mac""00:50:56:64:6760"}] 1

LongEPGName0123456789012345678901234567890123
Download Log 4567890123456789012

tn-Demo2/ap-AP/epg-webo1 i [ip""1.1.1.10" "mac":00:50:56:B.4:F5:5C"), 2
ac":"00:50:56:84:7C:51"}]

tn-Demo3/ap-AP/epg-web01 i 1110""mac’"00,5056:1111-117] 4

tn-t1/ap-ap/epg-App_2 0.26.10.3" "mac""54:7F-EE:29'50:8C")] 1

In-Tenantt/ap-AP/epg-app ['TAG-200'] 0:50:56:64:C4:52")] 1
tn-Tenant1/ap-AP/epg-web ['TAG-100"] 400505684 3E 17" g
Ti-est1/2p-APIEDg-2ppoT i 7

Total DN with endpoints: 8

To create policies using the dynamic addresses:

1. Goto Policy & Objects > IPv4 Policy.
2. Click Create New.
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3. Create a policy that allows communication from the web EPG to the app EPG as shown:

45

New Paolicy
@ Dashboard
N Security Fabric Name € WebtoApp
& FortiView Incoming Interface | & port5 vlan2767 v
+ Network Qutgoing Interface | @ porté_vlan2766 -
& System Source # WebEPG x
E Policy & Objects v *
I ey Destination i AppEPG x
1Pv4 Policy 77 # App .
Lcholcy Schedule 8 always -
IPv4 Access Control List Service o ALL ®
IPvé Access Control List *
IPv4 Dos Policy Action L@seaul @ DENY
IPv6 DoS Policy
Firewall / Network Options
Addresses
Wildcard FQDN NAT @
Addresses Proxy Options default - &
Internet Service Database
Goriless Security Profiles
Schedules AntiVirus >
Virtual IPs Web Filter o )
IP Pools DNS Filter >
Proxy Options Application Control (B
Traffic Shapers IPs o
Traffic Shaping Policy S5L Inspection >
& Security Profiles > . .
Logging Options
0 VPN >
Log Allowed Traffic [ OB Security Events EESHLNE
& User & Device >

Generate Logs when Session Starts (B

Capture Packets @ ]

= WiFi & Switch Controller >
il Log & Report >

a o IR
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4. Create a policy that allows communication from the app EPG to the web EPG as shown:

& Dashboard >
S Security Fabric >
i FortiView >
 Network >
& System >
B Policy & Objects
1Pv4 Policy
IPv6 Policy
IPv4 Access Control List
IPv6 Access Control List
IPv4 DoS Policy

IPv6 DoS Policy
Addresses

Wildcard FQDN
Addresses

Internet Service Database
Services

Schedules

Virtual IPs

IP Pools

Praxy Options

Traffic Shapers

Traffic Shaping Policy
& Security Profiles >
O VPN >
& User & Device >
= WiFi & Switch Controller >
il Log & Report >

Q

Deploying SDN Connector with FortiManager

Deploying SDN Connector when using FortiManager consists of the following steps:

== FortiGate 3700D FGT37D4615800597

-

New Policy

Name €@ ApptoWeb
Incoming Interface | @ porté_vlan2766
Outgoing Interface | @ port5 vian2767

Source # AppEPG x
+

Destination # WebEPG x
+

Schedule 6 always -

Service o ALL x
+

Action @ DENY

Firewall / Network Options

NAT (@]

Proxy Options default &

Security Profiles

AntiVirus »

Web Filter »

DNS Filter »

Application Control (B

IPS »

SSL Inspection @ ]

Logging Options

Log Allowed Traffic © ESENEE All Sessions

Generate Logs when Session Starts (B

Capture Packets @ ]

1. Configure a Fabric SDN Connector.

o oD

Create or import address objects.

Map the web and app interfaces.

Create policies leveraging the address objects.
Push the configuration to the FortiGate.

FortiOS Cisco ACI Administration Guide
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5. Ensure that an endpoint in the web EPG and an endpoint in the app EPG can ping each other.
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To configure a Fabric SDN Connector:

1. In FortiManager, go to Policy & Objects > Security Fabric > Fabric Connectors.

2. Click Create New.

a_m Policy & Objects v Policy Packages Object Configurations

& ADOM Revisions &% Tools ~

@ Zone/Interface + Create New
B Firewall Objects
@ Security Profiles

& Security Fabric

Threat Feeds

[# Edit W Delete = Import

5 Column Settings ~

£ More v

3. Configure the SDN Connector. The default port is 5671.

m_= Policy & Objects » Policy Packages Object Configurations

& ADOM Revisions £ Tools ~

47

@ Zone/Interface > | Create New Fabric Connectors
E Firewall Objects >
Name
i >
& Security Profiles Type
¥k Security Fabric ~

P

Fabric Connectors Port

Threat Feed
reat reeds User Name

B User & Device >
Password

Status

SDNConnector

Application Centric Infrastructure (ACI)
10.105.152.97

Use Default [JEbSGY

admin

[...........|

To create or import address objects:

To import address objects, do the following:

1. Go to Policy & Objects > Security Fabric > Fabric Connectors.

2. Right-click the newly created SDN Connector and select Import from the context menu.

&72 Policy & Objects v Policy Packages Object Configurations

£ ADOM Revisions 4% Tools v

@ Zone/Interface Bl 4 CreateNew [# Edit i Delete 3 Import %5 Column Settings v

» Firewall Objects >
© Security Profiles > = SDNConnector Application Centric Infrastructure (ACI)
¥ Eq]
3k Security Fabric v [# Edit
i Delete
Threat Feeds & Clone

£ User & Device >

31 Import

£ More v

10.105.152.97/5671

1 Enabled

ADOM: ADOM1

Last Modified
2018-09-25 13:18:49 admin/2018-09-25 1:1:18:49

3. Inthe Import SDN Connector dialog, select the EPGs to import. In this example, the AP|app and AP|web EPGs are

FortiOS Cisco ACI Administration Guide
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imported.

Import SDN Connector

Endpoint Group Tags

aplApp_2
aplApp_3
aplApp_4
aplApp_5
aplApp_6
ap|web_2
ap|web_3
ap|Web_4
ap|Web_5
ap|Web_é

APlapp
AP[db
AP|web

0O0D0DO0O0DO0ODO0OOODODOOOOTCO

~w Tenant: Tenant1 (2)
TAG-200
TAG-100

APlapp
AP|web

TAG-58,TAG-5,TAG-B,TAG-27TAG-0.TAG-41, TAG-92 TAG-84,TAG- 7, TAG-78,TAG-6,TAG-34, TAG-23 TAG-20,TAG-2
TAG-51,TAG-69,TAG-1,TAG-24,TAG-33 TAG-84,TAG-13,TAG-11 TAG-39,TAG-34,TAG-76,TAG-44, TAG-57,100,TAG
TAG-13,TAG-64,TAG-80,test-tag200,TAG-12 TAG-45,TAG-18,TAG-41,TAG-73 TAG-89 TAG-37 TAG-42,TAG-95,TAC
TAG-25,TAG-26,test-tag200,TAG-54,TAG-24,abcdefghijkimnoparstuvwxyz TAG-44,TAG-76,TAG- 69, TAG-86, TAG- 1t
TAG-5,TAG-58TAG-61,TAG-88,number_100TAG-30,TAG-11,TAG-12 TAG-94,TAG-37,1234567890,TAG-97 TAG-7*
TAG-23,TAG-25TAG-27 TAG-8,TAG-0,TAG-15,TAG-62,TAG-4,TAG-58,TAG-2, TAG-43 TAG-88,TAG-16,TAG-94,TAG-
TAG-29.TAG-22 TAG-97 abcdefghijklmnopgrstuvwxyz TAG-58 TAG-67 TAG-41 TAG-78 TAG-15 TAG-19,TAG-6,TAG
TAG-13,test-tag2000,TAG-4.TAG-62,TAG-30 TAG-0,TAG-27 TAG-78.TAG-24 TAG-85, abcdefghijklmnopgrstuvwxyz;
TAG-13TAG-0TAG-27 TAG-8 TAG-88 TAG-41.TAG-83 TAG-73 TAG-46,TAG-78 TAG-58 TAG-2 TAG-52 TAG-5,TAG-
TAG-16TAG-61TAG-31 TAG-64,TAG-40,TAG-68 TAG-71 TAG-30,TAG-36,TAG-39 TAG-76,TAG-44 TAG-97 TAG-37

To manually create address objects, do the following:

1. Go to Policy & Objects > Firewall Objects > Addresses.

2. Click Create New > Address.

Policy & Objects «»  Policy Packages Object Configurations

48

ADOM: ADOM1

& ADOM Revisions £ Tools v

+ Create New ~ [ Edit

Address Group
IPv6 Address
IPv6 Address Group

[ Zone/Interface > Bl Delete

& Firewall Objects ~
ORTAL_ADDRESS

. DDR1
‘Wildcard FQDN Addresses

Services

nonA

£5 Column Settings ~

2 More v
Details
1P/Netmask:0.0.0.0/0.0.0.0

IP Range:10.212.134.200-10.212.134.210

Fabric Connector Address (ACI): Tenant1(Tenant),AP|app(Endpoint Group Name),*(SDN Tag)
Fabric Connector Address (ACI): Tenant1(Tenant) AP|web{Endpoint Group Name),(SDN Tag)

D sslven_tun_intf

< any

Interface

any

» any

Created Time
2018-09-04 16:14:15  ad
2018-09-04 16:14:15 ad
2018-09-25 13:22:03 ad
2018-09-25 13:22:04 ad
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Configure a dynamic address for the web EPG. Ensure that the format for the endpoint group name is entered as
"Application Profile name|EPG name". This is case-sensitive. In Cisco ACI deployment on page 28, the application
profile was named "AP", and the EPGs were named "app" and "web". Therefore, the correct format is AP|app and
AP|web, as shown below.
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Policy & Objects v  Policy Packages Object Configurations

& ADOM Revisions £ Tools +

@ Zone/Interface > FIEI(!NEWMEI‘HS
B Firewall Objects ~ Address Name ‘WebAddress
Beldgsees Type Fabric Connector Address v]
Wildeard FQDN Addresses SDN Application Centric Infrastructure (ACI) v
Services Tenant Tenant1
Schedules Endpoint Group Name AP|web
Virtual IPs SDN Tag [Tac-200 ]
1P Pools Interface | <rany v ‘
Traffic Shapers Static Route Configuration OFF
& Security Profiles > Camment= 0/255
Sk Security Fabric ~
Fabric Connectors A
Threat Feeds Add To Groups Click here to select
A& User & Device > Advanced Options >
Per-Device Mapping OFF

4. Repeat steps 2 and 3 to configure a dynamic address for the app EPG.

To map the web and app interfaces:

1. Goto Policy & Objects > Zone/Interface > Interface.
2. Click Create New > Dynamic Interface.

7% Policy & Objects '+ Policy Packages  Object Configurations

ADOM: ADOM1

& ADOM Revisions % Tools v

@ Zone/Interface Bl +CreateNew~ [# Edit B Delete % Column Seftings~  { More v

Description Created Time Las

Interface C Default Mapping. Per-Device Mapping
2 Fircusll Obiccts > I Zone I ———

C Virtual Wire Pair > Ooutof 10
T — » Ooutof 10

@ Security Profiles >

3. Create an interface for the web EPG that maps to the correct port and VLAN.

Per-Device Mapping

Mapped Device 15248(NYC)

Device Interface [ port5_vlan2767
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4. Repeat step 3 for the app EPG.

Per-Device Mapping

Mapped Device 15248(NYC)

Device Interface [ porté_vlan2766

To create policies leveraging the address objects:

1.

Go to Policy & Objects > Policy Packages > default > Installation Targets.

2. Click Add.

&= Policy & Objects v  Policy Packages Obiject Configurations: ADOM: ADOM1

B Policy Package v s Install v & ADOM Revisions £ Tools v 5* Collapse All

O Installation Target Config Status

1Pv4 Policy
Installation Targets

In the Add Installation Targets dialog, select the managed FortiGate. Click OK.

Add Installation Targets

O Installation Target Config Status Policy Package Status
Synchronized Unknown
8] @ 4923 [NAT] ~ Synchronized A Never installed
a @ 9101 [NAT) ~ Synchronized A Never installed
8] @ ACIFW [NAT] ~ Synchronized A Never installed
a & FGSP48 [NAT] ~ Synchronized A Never installed
8] @ L2Vdom [Transparent] ~ Synchronized A Never installed
@ NYC [NAT] Synchronized | A Never installed

@ ServerVDom [NAT] + Synchronized A Never installed

oo

& root [NAT] (Management) + Synchronized A Never installed

O i Managed FortiGate

4. Go to Policy & Objects > Policy Packages > default > IPv4 Policy.
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5. Click Create New.

Policy & Objects + Policy Packages Object Configurations ADOM: ADOM1

B Policy Package v ch Install ~ @ ADOM Revisions ##Tools v # Collapse All - #= Object Selector v

Create New v [#jEdit~ Fi Delete [B]Section v & Column Settings~ @ View Mode

Destination

Schedule Service Security Profile: Log

@ NoLog

6. Create a policy that allows communication from the web EPG to the app EPG as shown:

Policy & Objects -~ Policy Padages Object Configurations

R Policy Package ~ & Install ~ & ADOM Revisions #% Tools ~  # Collapse All 3=

bject Selector v

Search. Q|| Edit 1Pv4 Policy
=+ & default
1Pvd Name ‘WebEPGtoAPPEPG
r—ets Incoming Interface 2 webinterface [x]
Outgoing Interface 28 Appinterface Q
Source Internet Service OFF
Source Address # Tenant1-AP|web Q
Source User +
Source User Group +
Source Device +
Destination Internet Service OFF
Destination Address # Tenant1-APlapp []
Service @WALL 1]
Schedule @ always Q
Action Deny IPSEC
Log Traffic (OMolog ®Log Security Events () Log All Sessions
O Generate Logs when Session Starts
DCapturc Packets
NAT a
Security Profiles (m}
Shared Shaper -
Reverse Shaper +
Per-IP Shaper +
Comments ‘
i
Advanced Ootions >
L x| |
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7. Create a policy that allows communication from the app EPG to the web EPG as shown:
Policy & Objects Policy Packages Object Configurations

& Policy Package ~ & Install & ADOM Revisions % Tools ~ ¢ Collapse All 3= Object Selector ~

search.. Q| Edit 1Pv4 Policy
= & default

1Pv4 Policy Name AppEPGtoWebEPG

Installation Targets Incoming Interface 2 Applnterface [x]
Outgoing Interface & webinterface Q
Source Internet Service OFF
Source Address # Tenant1-AP|app [x]
Source User +
Source User Group +
Source Device +
Destination Internet Service OFF
Destination Address B Tenant1-AP|web Q
Service WALL 1]
Schedule Balways Q
Action Deny IPSEC
Log Traffic (ONoLlog ®Log Security Events (O Log All Sessions

O Generate Logs when Session Starts
DCapturc Packets

NAT o
Security Profiles [m}
Shared Shaper +
Reverse Shaper +
Per-IP Shaper +

Comments ‘

Advanced Ootions >

To push the configuration to the FortiGate:

1. Goto Policy & Objects > Policy Packages > default > IPv4 Policy.
2. Click Install > Install Wizard.

&°5 Policy & Objects v  Policy Packages Object Configurations ADOM:ADOML I @

2 Policy Package v v & ADOMRevisions %% Tools~ s Collapse All 7= Object Selector
- Tnstall Wizard

Re-install Policy

w~ [#Edit~ i Delete [BlSection 3 Column Settings - © View Mode

Source Destination  Schedule Service Users Action Security Profile: Log NAT ‘Comments

[SIRE WebEPGtoAPP & webinterfaci & Applnterface # Tenant1-AP| # Tenant1-AP| [ always TALL + Accept ® Log Security Events € Disabled

AppEPGtoWebl 2& Appinterface 2 webinterfaci # Tenant1-AP|  Tenant1-AP| @ always + Accept @ Log Security Events € Disabled

Implicit Deny  <» £ always @ No Log

In the Install Wizard, ensure that the default policy package is selected. Click Next.
Select the managed FortiGate. Click Next.

Ensure that the summary is correct, then click Install.

When installation is complete, click Finish.

In FortiOS, go to Policy & Objects > IPv4 Policy to ensure that the policies were pushed and are configured as
desired.

No akso
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= _= FortiGate 3700D FGT37D4615800597 = 2 @ 20 @ admin-

& \vC Y| 4+ createNew | ¢ Edit Delete | Q Policy Lookup | | Search Q Interface Pair View [ZECRICICH

@ Dashboard >

1D Name Source Destination Schedule Service Action NAT Security Profiles Log Bytes

34 Security Fabric
4 FortiView

b Network 1 'WebEPGtoAPPEPG $#§ Tenant1-AP|web $#§ Tenant1-AP|app S always AL v ACCEPT © Disabled 0 ut™M 4808
# System
B Policy & Objects

1Pv4 Policy

2 ApPEPGLoWebEPG # Tenant1-APlapp 3 Tenant1-AP|web [0 always AL ¥ ACCEPT © Disabled +

U UM 4808

» R

1Pv6 Policy

1Pv4 Access Control List

8. Ensure that an endpoint in the web EPG and an endpoint in the app EPG can ping each other.

Monitoring SDN connector status using an API

You can monitor SDN connector status using a REST API that Fortinet SDN Connector for Cisco ACl and Nuage
Networks provides.

Request:
/api/status
Response:

Format: json

Key Type Possible values Description
in sync Boolean e true Whether endpoints are synchronized with
e false upstream SDN controller.
rpc_listener String e connected Send and receive notifications to and from
e disconnected FortiOS and FortiManager.
e uninitialized e connected: SDN connector connected to
RabbitMQ for receiving and sending
notifications
e disconnected: connection to RabbitMQ
is down.

e uninitialized: SDN connector has not
initialized connection with RabbitMQ yet,

during startup stage
sdn_controller String e connected Controller that the SDN connector connects to in
e disconnected order to get endpoint updates.

e connected: SDN connector connection to
SDN controller is successful.

e disconnected: SDN connector
connection to SDN controller fails due to
outage or invalid username/password or
has not completed yet.

sdn_controller_ String  IP address IP address or FQDN of the SDN controller that
host « FQDN the SDN connector is connecting to.
type String e aci Current SDN controller type.
e nuage
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Key Type Possible values
time Integer Epoch time in seconds
usage Dictionary

usage.cpu Float 0-100

usage.mem Float 0-100

version String X.

The following is an example of the output:

{
"in sync": true,
"rpc listener": "connected",
"sdn controller": "connected",
"sdn controller host": "x.x.x.x",
"time": 1584398898,
"type": "aci",
"usage": {
"cpu": 7.6,
"mem": 69.7
}I
"version": "1.1.3"

}

54

Description

Current epoch time stamp.

SDN connector CPU usage.
SDN connector memory usage.

Version number in major.minor.patch format.

The following shows sample code for monitoring the SDN connector using this API:

#!/usr/bin/env python
import re
import requests

class SdnConnectorClient (object) :

def init (self, host, password, user="admin@sdn-connector.local"):

self.host = host

self.base url = "https://" + host

self.user = user
self.password = password
self.csrf = None
self.cookies = None

def login(self):

login page = requests.get(self.base url + '/login', verify=False)

session = login page.cookies

regex = re.compile(".+csrf token=\\'(\S+)\\'.+")

self.csrf = regex.search(login page.text) .group (1)

form = {"email": self.user, "password": self.password,

"csrf token": self.csrf, "Login", "next": "/"}

res = requests.post(self.base url + data=form,
verify=False, cookies=session,
headers={'referer': self.base url})

self.cookies = res.cookies

def get status(self):
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res = self.get('/api/status')
return res[1l]

def get(self, path):
res = requests.get(self.base url + path, cookies=self.cookies,
verify=False)
return res.status code, res.text

def post(self, path, data):
res = requests.post(self.base url + path, cookies=self.cookies,
data=data, verify=False)
return res.statusicode, res.text

if name == " main ":
sdn _client = SdnConnectorClient ('localhost', 'xxxxxx')
sdn client.login ()
print sdn client.get status()

FortiGate built-in connector

You can use the Cisco ACI (Application Centric Infrastructure) connector for northbound API integration with a direct
connection.

Multiple server IP addresses can be included for the Cisco APIC cluster active and standby hosts. One server is active,
and the rest serve as backups in case the active server fails. The FortiGate checks the status of the servers, and selects
one as the active server according to the order of the IP addresses in the list. If the active server fails, the FortiGate
changes to the next one down on the list.

This connector supports the following address filters:

o Tenant

« Application

« Endpoint group
o Tag

To configure a Cisco ACI connector in the GUI:

1. Create the Cisco ACI SDN connector:
a. Go to Security Fabric > External Connectors and click Create New,.
b. Inthe Private SDN section, click Application Centric Infrastructure (ACI).
c. Configure the Connector Settings as needed. The update interval is in seconds.
d

In the Cisco ACI Connector section, for Type, select Direct Connection and configure the remaining settings as
needed.
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& Dashboard >

x Security Fabric ~
Physical Topology

Logical Topology

Security Rating

Automation
Fabric Connectors
rnal Connectors 54

& Network
£ System >
B Policy & Objects >
& Security Profiles >
o veN >
& User & Authentication >
Ll Log & Report >

a.
b.
c.

d. Click OK.

New External Connector

Private SDN

Application
Centric
Infrastructure
(ACl)

Connector Settings
Name

Status

aci_direct1

LRSELEVY © Disabled

Update Interval €@ JUSYREENIN Specify

Cisco ACI Connector

Type FortiSDN Connector
P 10.100.25.204

Username | Izou

Password ssssvesee @

2. Create a dynamic firewall address for the connector:
Go to Policy & Objects > Addresses.
Click Create New > Address and enter a name.
Configure the following settings:
i. For Type, select Dynamic.

For Sub Type, select Fabric Connector Address.
For SDN Connector, select the connector created in step 1.
For Filter, select an entry from the dropdown list. In this example, Application is selected.

Cancel

& Public SDN Connector Setup Guides

25 Amazon Web Services (2"

& Google Cloud Platform (£

A Microsoft Azure (!

=== Oracle Cloud Infrastructure ('

B Private SDN Connector Setup Guides

Nuage Virtualized Services Platform ('
& OpenStack Connector (£
nse VMware NSX (21

® Documentation

& Online Help &'
& Video Tutorials ('

HA:Master Q ~

Cisco Application Centric Infrastructure (2

& System >~
I B Policy & Objects v
Firewall Policy
Authentication Rules
Multicast Policy
Local In Palicy
IPv4 DoS Policy

Internet Service
Database

Services

Schedules

Virtual IPs

1P Pools

Protocol Options
Traffic Shapers
Traffic Shaping Policy
Traffic Shaping Profile
Virtual Servers

Health Check

Edit Address

Category
Name

Color

Type

Sub Type

SDN Connector
Filter

Interface
Showinaddresslist @©

Comments
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aci-direct-app
# | Change
Dynamic

Fabric Connector Address

aci_directl

-

Y Application=lzou-app
Q Search

jon 1
Y Application=Izou-app

Y Epg=lzou-epg-app
Y Epg=lzou-epg-db
Y Epg=lzou-epg-web

Y Tag=app-servers

Y Tag=db-servers

Y Tag=ubuntu-servers
Y Tag=web-servers
Tenant (1

Y _Tenant=tenant lzou

+ Create

Cancel

# Dy

Guides

\ddre

2% Configuring an AWS Dynamic Address ('

s Configuring an Azure Dynamic Address (£

3 Configuring a Google Cloud Platform Dynamic Address ('
Configuring an Qracle Cloud Infrastructure Dynamic Address (£

e

O Configuring an OpenStack Dynamic Address (2

@ Documentation

& Online Help
& Video Tutorials '
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3. Confirm that the connector resolves the dynamic firewall IP addresses:
a. Goto Policy & Objects > Addresses.
b. Inthe address table, hover over the address created in step 2 to view which IP addresses it resolves to:

HA:Master Q~ > [ @~ O (@) admin~

ortiGate VM64 Root-F-1~

.
£ System > # Edit  m Clone | [ Delete | | Search Q

I B Policy & Objects v
Name Type Details Interface Visibility Ref
Firewall Policy <
Authentication Rules i aci-add-tag Dynamic (ACI) @ Visible 0
Multicast Policy 3 aci-direct-app Dynamic (ACI-DIRECT) © Visible o
i  aci-direct-end 3ci-direct-app resolves to: Iy namic (ACI-DIRECT) © Visible 0
Local In Policy
* 1005.11
1Pv4 DoS Policy i aci-direct-tag|  « 100.5.12 Dynamic (ACI-DIRECT) @ visible 0
it P i acidirectten| ig;g 2 i; Dynamic (ACI-DIRECT) @ Visible O
Internet Service H# dliaddresssq  * 100613 IDynamic (ALICLOUD) @ Visible 0
Database » 100614
Zan * 100711 Subnet 0.00.0/0 & Visible 17
Services * 100712
B autoupdate.o, FQDN autoupdate opera.com © Visible 2
Schedules
pm—— aws-address-tag-1 Dynamic (AWS) @ Visible 0
irtual IPs
1P Pools aws-address-tag-2 Dynamic (AWS) @ Visible o]
Protocol Options aws-address-wildcard Dynamic (AWS) @ Visible o]
Traffic Shapers aws-autoscale-1 Dynamic (AWS) @ Visible 0
Traffic Shaping Policy $# azure_add1 Dynamic (AZURE) @ Visible 4]
Traffic Shaping Profile # charlie_test Dynamic (NSX) © Visible 0
Virtual Servers $# s ns_group Dynamic (NSX) @ Visible 0
Health Check i fot Dynamic (NSX) @ Visible o]
& Security Profiles > 3 gop-address-node-1 Dynamic (GCP) © Visible 0
8 VPN > | # gep-address-node-2 Dynamic (GCP) O Visible 0
& User & Authentication > | # gep-address-wildcard Dynamic (GCP) @ Visible 0
il | og & Report > ¥ Bt orn.ole Munamic (GEB) @ visibla 0 -

To configure a Cisco ACI connector in the CLI:

1. Create the Cisco ACI SDN connector:

config system sdn-connector
edit "aci directl”
set status enable
set type aci-direct
set server "10.100.25.204"
set username "lzou"
set password XXXXXXX
set update-interval 60
next
end

2. Create a dynamic firewall address for the connector:

config firewall address
edit "aci-direct-app"
set type dynamic
set sdn "aci directl”
set color 17
set filter "Application=lzou-app"
next
end

3. Confirm that the connector resolves the dynamic firewall IP addresses:

config firewall address
edit "aci-direct-app"
show
config firewall address
edit "aci-direct-app"
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set uuid 794aaf20-3e33-5lea-57el-10bbbadf3fc?
set type dynamic
set sdn "aci directl"

set color 17

set filter "Application=lzou-app"

config list
"10.0.5.11"

edit
next
edit
next
edit
next
edit
next
edit
next
edit
next
edit
next
edit
next
end
next
end
next
end

Configuring Cisco pxGrid SDN connector

"10.

"10.

"10.

"10.

"10.

"10.

"10.

0.

5.

12m

J11T

12"

.13"

.14

J11T

12"
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You can create an endpoint connector to Cisco pxGrid by using FortiManager. FortiManager dynamically collects
updates from pxGrid and forwards them to FortiGate by using the Fortinet Single Sign On (FSSO) protocol.

To create a Cisco pxGrid SDN connector:

1. On FortiManager, create an SSO Connector to Cisco ISE.

Communication between FortiManager and Cisco ISE is secured by using TLS. FortiManager requires a client

certificate issued by Cisco ISE. FortiManager uses the certificate to authenticate to Cisco ISE.
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Policy & Objects »+  Policy Packages Object Configurations

B Policy Package ~ & Install @ ADOM Revisions % Tools~ Collapse All 3= Object Selector ~

Q| Edit IPv4 Policy

- Dy default

Name

Installation Targets Incoming Interface [any [x]
Outgoing Interface Clany o
Source Internet Service OFF
Source Address =all 2
Source User +
Source User Group &aISE-group [x]
FSSO [~]
RSSO o
Destination Internet Service oFF
Destination Address =all L]
Service WALL (2]
Schedule @ always e
Action Deny IPSEC
Log Traffic (ONolog (@Log Security Events (O Log All Sessions

[ Generate Logs when Session Starts
[ Capture Packets
NAT (=]
Security Profiles o
Shared Shaper +
Reverse Shaper +
Per-IP Shaper +
Comments
/1023

2. On FortiManager, map Cisco ISE groups to a Fortinet FSSO group.
Once a secured communication channel is established, Cisco sends all user groups to FortiManager.

The FortiManager administrator can select specific groups and map them to Fortinet FSSO groups.

Policy & Objects v Policy Packages  Object Configurations

@ ADOM Revisions £ Tools v

@ Zone/Interface > | Edit User Group
® Firewall Objects 2| ohprine ISE-group
@ Security Profiles > Te OFirewall @FSSO/Cisco TrustSec OGUEST  RADIUS Single Sig:
% Fabric Connectors | Members 5 Select Entries (Total: 22) x
f2 User & Device ~ 2 pxisel_Guests x| L2
User Definition 1 Entry Selected [ px_ise1 ANY. 2l

Custom Devices & Groups
LDAP Servers

RADIUS Servers
TACACS+ Servers

SMS Services

FortiTokens
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[71& px_isel_Agroupl

[ px_isel_Agroup2

[71& px_isel_Auditors

[ px_ise1_BYOD

[ px_isel_Contractors

[71&% px_isel_Developers

[14% px_ise1_Development_Servers
[ px_ise1_Employees

o2 nx isel Guests

® 0

B3 cancel
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3. On FortiManager, add Fortinet FSSO group to a firewall policy in a policy package.

Policy & Objects »+  Policy Packages Object Configurations

B Policy Package ~ & Install @ ADOM Revisions % Tools~ Collapse All 3= Object Selector ~

[ 12 B Q| Edit 1Pva Policy

= default
Name

Installation Targets Incoming Interface any [x}

Qutgoing Interface Cany Q
Source Internet Service OFF
Source Address =all e
Source User +
Source User Group &aISE-group [x]
FSS0
RSSO o
Destination Internet Service OFF
Destination Address Sall L)
Service WALL [~
Schedule @ always L]
Action Deny IPSEC
Log Traffic (ONolog (@ Log Security Events (O Log All Sessions

[ Generate Logs when Session Starts

[capture Packets

NAT o
Security Profiles [m}

Shared Shaper +
Reverse Shaper +
Per-IP Shaper +

Comments

0/1023

B T

4. On FortiManager, synchronize the policy package to the firewall for the managed FortiGate.

Install Wizard - Policy Package (default)

+ Installation Preparation Total: 2/2, Success: 2, Error: 0, Warning: 0 (0]
Index  Name Status
1 FortiGate-400D[copy] - root Copy to device done
2 Write summarylpreview] Write preview done

+ Interface Validation
+ Policy and Object Validation

 Ready to Install

A Device Name Status Action

FortiGate-400D[root] Connection Up ] instat preview | poicy Package Diff

5. On FortiGate, verify that the synced firewall policy contains the correct FSSO group and that all FSSO-related
information in user adgrp is correct.
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6. After successful user authentication on Cisco ISE, verify that information is forwarded to FortiManager.
On FortiManager, the icon next to the authenticated user in pxGrid Monitor should be green.

pxGrid Monitor - isel

guestl Q
© &px_isel Guests (1/417)
guestl

2 guesti00

2 guesti01

2 guest102

2 guest103

2 guest104

2 guest105

2 guest106

2 guest107

2 guest108

2 guest109

2 cuact11n

X @ Ie

€ C O AN

“diib: igentiy Services Engine  Home

e | https;//172.18.78.206/admin/#monit

» Administration  » Work Centers

~RADIUS | Threat-Centric NAC Live Logs  » TACACS b Troubleshoot ) Adaptive Network Control  Reports
Click here to do wireless se'
Live Logs _ Live Sessions

Refresh | Every 3seconds v | show| Lat
T Reflesh & Export Tov
Initiated Updated

Session Status  Action Endpoint ID Identity

354819PM  Apr02,2010024354824PM  Started Show CoAActions  00:0C:29:44:BE:B9 questi

Last Updated: Tue Apr 02 2019 14:44:46 GMT.0700 (Pacific Daylight Time)

FortiGate should have two entries: one in the firewall-authenticated user list and one in the FSSO logged-on user

list.

In the FSSO logged-on user list, you can view both groups. You view the group that the user belongs to on Cisco

ISE and the Fortinet FSSO group.
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Multiple clusters on Cisco ACI connectors
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You can include multiple ACI clusters used in availability for external Cisco ACI SDN connector VMs. When creating a
Cisco ACI SDN connector, configuring multiple IPs allows the FortiGate to connect to SDN connector VMs in the same
ACI cluster in a round-robin fashion. Only one SDN connector VM is active, and the remaining serve as backups if the

active one fails. FortiOS 6.4.9 and later versions support this feature.

In this example, two Cisco ACI cluster SDN connectors are configured (aci_robot_238 and aci_robot_239). Each cluster
contains two Cisco ACI SDN connector VMs.

To create ACI cluster SDN connectors in the GUI:

1. Goto Security Fabric > External Connectors and click Create New.
2. Select Application Centric Infrastructure (ACI) and configure the following:

Name
Type

IP

Port
Username

Password

FortiOS Cisco ACI Administration Guide

aci_robot_238
Set to FortiSDN Connector.

Enter two IP addresses: 10.6.30.38 and 710.6.30.238.

Set to Specify and enter 5671.
Enter the ACI username.

Enter the ACI password.
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Edit External Connector

Private SDN

Connector Settings
Name aci_robot_238

Status L HELEE © Disabled

Cisco ACI Connector

Type [Tl fechl el Direct Connection

P 10.6.30.38 x
10.6.30.238 x
[+]
Port Use Default 5671
Username | admin
Password esssssss Change
3. Click OK.

Status

Q Up

& Public SDN Connector Setup Guides

= Amazon Web Services (£
& Google Cloud Platform (&
/A Microsoft Azure ('
+ Oracle Cloud Infrastructure ('

B Private SDN Connector Setup Guides

% Cisco Application Centric Infrastructure ('
Nuage Virtualized Services Platform (2

O OpenStack Connector &

nsx VMware NSX ('

® Documentation

& OnlineHelp &'
& Video Tutorials

4. Repeat these steps to create another connector with the following settings:

Name
Type

IP

Port
Username

Password

aci_robot 239
Set to FortiSDN Connector.

Enter two IP addresses: 10.6.30.39 and 10.6.30.239.

Set to Specify and enter 5671.
Enter the ACl username.

Enter the ACI password.

To create dynamic addresses associated with the connectors in the GUI:

1. Goto Policy & Objects > Addresses and click Create New > Address.

2. Configure the following:

Name

Type

Sub Type

SDN Connector
Tenant

Endpoint Group Name

FortiOS Cisco ACI Administration Guide

aci-add-App-238
Dynamic

Fabric Connector Address
aci_robot_238

Fortinet

App1
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Edit Address
o . . . FortiGate
Category Pv6 Address | Multicast Address | Proxy Address
FGTA-1
Name aci-add-App-238 L N
Color # | Change # Dynamic Ac
Type - Guides
Sub Type - L Conﬁgur}nganA\NS Dynami(erddress =z
A Configuring an Azure Dynamic Address (4
SDN Connector aci_robot_238 ~ Configuring a Google Cloud Platform Dynamic Address ('
Tenant Fortinet ==+ Configuring an Oracle Cloud Infrastructure Dynamic Address (£

3 Configuring an OpenStack Dynamic Address (4"
Endpoint Group Name | Appl

SDN Tag (@ Documentation
Interface O an - & Online Help &'
L2 W Video Tutorials (£
Comments Write acomment Zlos2as5
3. Click OK.

4. Repeatthese steps to create another dynamic address with the following settings:

Name aci-add-App-239

Type Dynamic

Sub Type Fabric Connector Address
SDN Connector aci_robot 239

Tenant Fortinet

Endpoint Group Name App1

To test that firewall addresses can resolve the dynamic addresses based on the SDN connector in the
GUI:

1. Goto Policy & Objects > Addresses.
2. Hover the cursor over an address. The tooltip shows the resolved addresses of the dynamic firewall address.
& Edit "W Clone W Delete Search Q i Synchronized

Name T Details Interface Fabric Sync Type Ref.
[ Dynamic (ACl) @
# aci-add-App-238 # aci-add-App-238 © Disable Address 0

© Disable Address 0

3 aci-add-App-239
Dynamic
Fabric Connector Address
+ aci_robot_239
Fortinet

pName Appl

O any

57.244.1411 42.204.249.3 113.20.146.15
22220.24424  136.111.12028 232.68.132.53
159.10.165.63  158.68.111.87  193.182.254.90
153.11.53.97 137.225.232.98 127.13%9.171.102
246.238.232.107 18%.130.18%.117 145.225.9.121
61.85.89.127 254.63.148.141 255.101.230.147
164.95.140.151 118.223.37.174 213.112.26.175
67.82.175.177  171.%0.10%9.180 15.216.40.150
106.97.0.201 247.186.79.208 112.237.77.209
21.90.161.213  156.8.243.247 79.85.64.251

© Disabled

0

# Edit

T 2/75|Updated: 11:06:39 | &
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To create ACI cluster SDN connectors in the CLI:

config system sdn-connector
edit "aci robot 238"
set type aci
set server-list "10.6.30.38" "10.6.30.238"
set server-port 5671
set username "admin"
set paSSWOrd * Kk k ok ok ok k ok ok k
next
edit "aci robot 239"
set type aci
set server-list "10.6.30.39" "10.6.30.239"
set server-port 5671
set username "admin"
Set password *kkkkkkkk*k
next
end

To create dynamic addresses associated with the connectors in the CLI:

config firewall address
edit "aci-add-App-238"
set type dynamic
set sdn "aci robot 238"
set color 17
set tenant "Fortinet"
set epg-name "Appl"
next
edit "aci-add-App-239"
set type dynamic
set sdn "aci robot 239"
set color 17
set tenant "Fortinet"
set epg-name "Appl"
next
end

65

To test that firewall addresses can resolve the dynamic addresses based on the SDN connector in the

CLI:

1. Check the aci-add-App-238 address:

# diagnose firewall dynamic address aci-add-App-238
aci robot 238.aci.Fortinet.Appl.*: ID(90)
ADDR(244.141.232.3)
ADDR(124.37.216.5)
ADDR (178.77.227.6)

ADDR (87.26.255.252)
ADDR(31.45.199.254)
ADDR (154.149.224.254)

Total dynamic list entries: 1.

Total dynamic addresses: 150
Total dynamic ranges: 0

FortiOS Cisco ACI Administration Guide
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2. Check the aci-add-App-239 address:

# diagnose firewall dynamic address aci-add-App-239
aci robot 239.aci.Fortinet.Appl.*: ID(91)
ADDR(57.244.141.1)
ADDR (42.204.249.3)
ADDR(113.20.146.15)

ADDR(21.90.161.213)
ADDR (156.8.243.247)
ADDR (79.85.64.251)

Total dynamic list entries: 1.

Total dynamic addresses: 30
Total dynamic ranges: 0

FortiOS Cisco ACI Administration Guide
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Date Change description

2020-08-05 Initial release.
2020-08-20 Updated Configuring the Cisco ACI connector in FortiOS on page 17.
2020-08-21 Updated SDN Connector integration with Cisco ACI on page 17.
Added Configuring VDOM and SDN connector example on page 17.
2020-09-22 Updated Configuring the Cisco ACI connector in FortiOS on page 17.
2021-02-18 Added Configuring Cisco pxGrid SDN connector on page 58.
2021-11-02 Added HA on Cisco ACI using FGCP over FGSP on page 4.
2022-04-26 Added Multiple clusters on Cisco ACI connectors on page 62.
2024-03-06 Updated Configuring FortiOS on page 12.
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